





Praise for

SUPER SCRATCH
PROGRAMMING ADVENTURE!

“Reveals the power of this deceptively simple programming language . . .
A fun way to learn how to program Scratch, even for adults.”
—Mark Frauenfelder, Boing Boing

“A great introduction to game design. Kids will start building games
from the first page.”
—Liz Upton, The Raspberry Pi Project

“If you think you might have a future programmer on your hands,
it’s time to introduce your kid to Scratch. . . . Super Scratch Pro-
gramming Adventure! makes it even easier to get started.”
—Ruth Suehle, GeekMom

“If you have a kid who plays around with a computer and can read
even a little, get this.”
—Greg Laden, National Geographic’s ScienceBlogs

“An enjoyable and highly accessible introduction to this technology
and the power of computing.”
—Patrice Gans, Education Week’s BookMarks

“If you've got a child or maybe even a classroom of students who are
wanting to make their own games, Scratch is a great option. . . . For
structured training that is also entertaining, Super Scratch Program-
ming Adventure! will make a great textbook.”

—dJames Floyd Kelly, GeekDad

“Walks readers through a series of extremely well-designed game-design
projects, each of which introduces a new concept or two to young pro-
grammers, providing a gentle learning curve for mastering Scratch’s
many powerful features.”

—Cory Doctorow, Boing Boing

“If you're looking for a way to get your kid interested in programming,
and Scratch in particular, I can’t recommend this Scratch book enough.”
—Chris O’Brien, San Jose Mercury News’ SiliconBeat
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FOREWORD BY PROFESSOR MITCHEL RESNICK

A NOTE OF THANKS FROM
DR. ROSANNA WONG YICK-MING

A NOTE FOR PARENTS AND EDUCATORS
MEET THE CAST

STAGE 1: RIDING A FLARE FROM THE SUN

Let’s get to know Scratch! We'll also learn about sprites
and coordinates.

STAGE 2: ENTERING SPACE

This is where you’ll make your the first game. You’'ll also
learn how to create new costumes and program a sprite’s
movements, reactions, and sound effects.

STAGE 3: TRAPPED BY MONA LISA'S SMILE

While writing this two-part game, you'll learn how to
control the flow of a Scratch project. You’ll see how to

keep score using variables and control the order of the
game using broadcasts.

STAGE 4: DEFEND HONG KONG'S TECHNOCORE

You’ll learn to control sprites with the mouse, program
objects to bounce back, and more.

STAGE 5: PENALTY KICK IN IPANEMA

You'll program a soccer game with a targeting system,
several related rules, interactive sound effects, and a
vivid, animated background!
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You'll learn how to create a side-scrolling racing game,
program complex movements for sprites, and make the
game’s background change over time.

STAGE 7: THE LOST TREASURES OF GIZA

In this Egyptian adventure, you’ll create an interactive
maze with a guard, booby traps, and treasure!

STAGE 8: WIZARD'S RACE!

When you make this simple button-mashing game, you'll
also learn how to play music with Scratch and create an
animated background.

STAGE 9: THE FINAL FIGHT...IN DARK SPACE

You'll need to use all the knowledge you've gained while
making this exciting fighting game. You'll create two
characters with unique fight moves, custom health
counters, and more.

STAGE 10: EPILOGUE

CLOSING THOUGHTS FROM
EDMOND KIM PING HUI
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FOREWORD

Scratch 1s more than a piece of software. It

is part of a broader educational mission. We
designed Scratch to help young people prepare
for life in today’s fast-changing society. As young
people create Scratch projects, they are not just
learning how to write computer programs. They
are learning to think creatively, reason system-
atically, and work collaboratively—essential
skills for success and happiness in today’s world.

It has been exciting to see all of the creative ways that young
people are using Scratch. On the Scratch website (http://scratch
.mit.edu/), young people from around the world are sharing a wide
variety of creative projects: animated stories, adventure games,
interactive tutorials, guided tours, science experiments, online
newsletters, and much more. Scratch is a digital sandbox where
young people can express themselves creatively—and, in the process,
develop as creative thinkers.

Super Scratch Programming Adventure! will help introduce
more young people to the creative possibilities of Scratch. The book
grows out of one of the world’s most innovative and productive Scratch
initiatives, organized by the Hong Kong Federation of Youth Groups.
I'm delighted that their ideas and activities are now available to
teachers, parents, and children around the world.

As you read this book, let your imagination run wild. What will
you create with Scratch?

Enjoy the adventure!

MMN.O Tesmth_

Professor Mitchel Resnick
Director, MIT Scratch Team
MIT Media Lab



A NOTE OF THANKS

The Hong Kong Federation of Youth Groups
created the Learning through Engineering,

Art and Design (LEAD) Project in 2005 in
collaboration with the MIT Media Lab and the
Chinese University of Hong Kong. The LEAD
Project promotes hands-on, design-based activities
with the creative use of technology and aims to
develop an innovative spirit among the youth of
Hong Kong. Since its founding, it has promoted
technology education on a grand scale, reaching
more than 1,000,000 students, parents, and
educators.

Super Scratch Programming Adventure! is our second of three
books about Scratch and the first to be translated into English.
This book highlights the playful spirit of learning to program with
Scratch, which inspires young people to apply digital technologies in
imaginative and innovative ways.

We are very grateful to the MIT Media Lab, which has been our
partner since LEAD was established in 2005. We are particularly
appreciative of Professor Mitchel Resnick and Mr. Michael Smith-
Welch, who have always been LEAD’s staunchest supporters and
greatest cheerleaders. Because of their unwavering belief in Scratch
and in LEAD, you are now able to read this English edition.

We hope this book inspires you to design your very own games,
projects, and more with Scratch.

(it v

Dr. Rosanna Wong Yick-ming, DBE, JP
Executive Director
The Hong Kong Federation of Youth Groups




Scratch opens up an exciting world of computer programming
for kids and other beginning programmers. To follow along with
this book and use Scratch 2.0, you’ll need:

* A computer with a recent Web browser (Chrome 7 or later,
Firefox 4 or later, or Internet Explorer 7 or later) with Adobe
Flash Player version 10.2 or later installed

+ A display that’s 1024 x 768 or larger
* A reliable Internet connection

* A microphone and speakers (or headphones) to record and
listen to music

Once you have a browser and Adobe Flash Player installed,
just point your browser at http://scratch.mit.edu/. You can create
a new Scratch project without logging in by clicking the Create
button. You'll want to eventually Join Scratch to create your
own account and save your projects (see how in “Join the Com-
munity!” on page 15).

You should download the projects used in this book from
http://nostarch.com/scratch/. This online resource includes
complete working projects, custom sprites, and a short Getting
Started with Scratch guide produced by the Scratch team.




NOTE The Resources file includes two versions of each game
in the book. One version is a completely finished and
playable game, perfect for young learners and anyone
who wants to build on the games in the book. The
second set of projects has no programming added, so
that students can follow along with the programming
instructions in this book. Remember, there’s no wrong
way to play with Scratch!

BUT WHAT IS SCRATCH, ANYWAY?

Scratch is a graphical programming
language that you can use for free.
By simply dragging and dropping
colored blocks, you can create interac-
tive stories, games, animation, music,
art, and presentations. You can even
upload your creations to the Internet
to share them with Scratch program-

mers from around the world. Scratch

1s designed for play, self-directed

learning, and design.

WHERE DID THE NAME SCRATCH
COME FROM?

Scratch is named for the way that hip-hop disc jockeys (Dds)
creatively combine pieces of music, using a technique called
scratching. In the same way, Scratch programmers join different
media (images, photos, sound effects, and so on) in exciting ways
to create something entirely new.

switch costume to Party Hat




WHO CREATED SCRATCH?

Scratch is a project funded by the US National Science Founda-
tion (NSF). It was developed by the Massachusetts Institute of
Technology (MIT) Media Lab’s Lifelong Kindergarten Group.

WHO IS SCRATCH FOR?

Scratch was developed for young people aged 8 and up to help
them develop creative learning skills for the 21st century. When
kids create programs, they learn important mathematical and
computer concepts that improve their creative thinking, logical
reasoning, problem solving, and collaboration skills.

This creative thinking spiral is from Professor Resnick’s article,
“Sowing the Seeds of a More Creative Society,” published in ISTE
(International Society for Technology in Education).




Designing Scratch projects challenges kids to think cre-
atively, and learning how to overcome obstacles and solve
problems builds confidence. This gives learners an advantage
later in life.

IS IT EASY TO USE SCRATCH?

Scratch was designed to prevent the common beginner pitfalls
in traditional programming languages, like misspelling and
errors in consistency. Instead of typing commands, programming
in Scratch is performed by dragging and joining programming
blocks. This graphical interface allows users to easily control the
way in which different types of commands react to each other.
Additionally, each block can fit with another only if it makes
computational sense. Colorized categories help organize and
group different sets of related commands based on their particu-
lar functions.

Since programs in Scratch run in real time, they can be
edited and tested at any given moment, even while the program
is running. This allows users to easily experiment with new
ideas or to repeatedly test their improvements!

HOW MANY LANGUAGES DOES
SCRATCH SUPPORT?

Scratch can be used in 50 different languages. Choose your
language from the pull-down menu at the bottom of the Scratch
website.

WHERE CAN YOU USE SCRATCH?

You can use Scratch at schools, libraries, community centers,
and home. Even though Scratch is designed for young people
aged 8 and up, younger children can also learn to design and
create alongside their parents or siblings.




Scratch is used around the world in elementary, middle, and
high schools. Computer science professors also use Scratch as a
means of introducing programming concepts to college students.

HOW CAN SCRATCH BE USED TO
EDUCATE IN SCHOOLS?

Schools can use Scratch to aid teachers in subjects like math-
ematics, English, music, art, design, and information technology.
Scratch is designed for exploration and experimentation, so it
supports many different learning styles.

No matter what they use Scratch for—creative storytelling,
unique video games, or simple demonstrations of programming
concepts—Scratch will provide a space for students to explore
and imagine. By engaging in design-based activity individually
or in groups, students will be motivated to learn.

Here are just a few of the things that students have used
Scratch to do:

* A school in New York City used Scratch to build simulations
of the spread of infectious diseases.

* A group of teenagers in India used Scratch to make an
animated map of their village, illustrating environmental
concerns where they live.




*  Students at a university in Istanbul used Scratch to examine
video game culture by rapidly prototyping their own games
and testing the games with the public.

+  English students in a middle school in California used
Scratch to build a random story generator.

*  Students in an elementary school in Russia used Scratch to
build their own personalized tutorials for learning about the
coordinate system and trigonometry.

*  High school students in Michigan used Scratch to build a
physics simulator.

The possibilities are endless. It is our sincere hope that
this book inspires students to create their own games, stories,
and more.

JOIN THE COMMUNITY!

Because Scratch is online, kids can easily share their own
Scratch projects with their friends, family, and teachers. Once
someone shares their work publicly on the Scratch website, other
Scratch programmers can remix their projects, give them feed-
back, and more.

Follow these steps to join Scratch:

1. Visit the Scratch home page (http://scratch.mit.edu/) and click
Join Scratch to register (you only need to register once).

2. Choose a username (don’t use your real name), and then fill
out the rest of the information. If the person registering is
under 13, Scratch will ask for the email address of a parent
or guardian.

NOTE Once you share a project, everyone in the whole world
can see what youve made! Make sure that your kids
or students know to keep their personal information
private.




As long as they have the username and password at hand,
kids can find games to play through the project gallery, remix
them, and share their thoughts with others from around the
world! To see how someone else’s game was built, just click the
See Inside button (EEEEY). To add to the program, click the
big orange Remix button ( ).

To share your own projects with the rest of the world, click
the big Share button (| sr== ) in the Scratch editor. To make a
project private again, click the Unshare button in the My Stuff
listing.

Just remember that as a member of the Scratch community,
you’'ll be sharing projects and ideas with people of all ages, all
levels of experience, and all parts of the world. So be sure to:

*  Be respectful of other players

*  Be constructive when commenting
+  Help keep the site friendly and fun
+  Keep personal information private

For more ideas and information about sharing and remixing
projects, visit http://wiki.scratch.mit.edu/wiki/Remix.




MY COMPUTER CAN'T RUN
SCRATCH 2.0!

If your computer doesn’t meet the requirements listed on

page 10, you can still download and install Scratch 1.4. (http://
scratch.mit.edu/scratch_1.4/). Scratch 1.4 projects are compat-
ible with the Web-based Scratch 2.0, and you can still share your
projects on the Scratch website using Scratch 1.4. (Unfortunately,
Scratch 1.4 cannot read programs created in the Scratch 2.0
software.)

You can download free PDF versions of Chapters 1 and 2,
which explain how the older 1.4 interface works, by visiting
http://nostarch.com/scratch/. You can also find versions of the
book’s games that are compatible with 1.4 on that page.

I'M AN EDUCATOR USING SCRATCH

Awesome! This book is great place to start for classes and after-
school programs. You'll want to download the free Educator’s
Guide at http://nostarch.com/scratch/. Visit the official Scratch
educator’s forum at http://scratched.media.mit.edu/ to exchange
resources, share success stories, and ask questions of other edu-
cators already using Scratch as an educational tool.

| STILL HAVE OTHER QUESTIONS...

You can find more information on the Scratch website:

Visit the Scratch FAQ at http://info.scratch.mit.edu/
Support/Scratch_FAQ/.

+  Visit the Scratch Help at http://scratch.mit.edu/help/.

“Online Resources” on page 156 has other helpful links.
For updates to this book, visit http://nostarch.com/scratch/.




Mitch

A computer science
student who loves to
make cool programs,
he’s passionate about

(~)
G movies and art, too!
Mitch is an all-around
> good guy.
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The Cosmic Defenders:

Gobo, Fabu, and Pele

The Cosmic Defenders are trans-
dimensional space aliens who can .
travel through space and time.
Formally deputized by the Galactic
Council, the Cosmic Defender’s duty
is to maintain the balance of the
universe.

The Dark Wizard

He is a shapeless yet powerful

and vengeful spirit, whose origins Scratchy ' -

are unknown. Nothing can stop An energetic cat.l|vmg in cyber-
his ambition of destroying the space, Scratchy is exactly what
order of space and time. you'd expec‘g from a cat on the

Internet. He’s quite curious and

| impulsive.
The Dark Minions
These pesky foes are Cosmic
Defenders who have fallen
to the dark side. They work
for the Dark Wizard now.
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STAGE

1

A SOLAR STORM A FLARE
RAGES ON THE EXPLODES WITH
SURFACE OF A BURST OF
THE SUN.... ENERGY!

I SURE WISH
PROGRAMMING
WERE EASIER...

MEANWHILE, IN
SCHOOL ON EARTH...

W-WHO ARE
COME ON, YOU? WHAT JUST
HAPPENED?



MY NAME IS
SCRATCHY.
I'M FROM

CYBERSPACE.

YOU'RE FROM A
COMPUTER?!

HEY MITCH.
UM...1$ YOUR
PLANET ALWAYS
S0 GRAY?

NO WAY!
SOMETHING'S
WRONG. LET'S

GO0 CHeECK
IT OUT!

STAY CALM!
THANK GOODNESS
I FOUND You!

YOUR BODY 15
BEING FROZEN!

THAT'S RIGHT. I
FOLLOWED THAT
FLASH OF LIGHT, AND
HERE I AM!

AMAZING! MY
NAME IS MITCH. TM A
COMPUTER SCIENCE

STUDENT!

OHNO!'1
CAN'T MOVE
MY LEGS!

WHERE 1S
EVERYBODY?
AHHH!
ME NEITHER!
SOMETHING HELP!!
TERRIBLE 15
FORMING IN
THE 5KY!

TAKE THIS
SECRET MANUAL
BEFORE THE
BLACK TORNADO
SWALLOWS You!
THEN FOLLOW MY
INSTRUCTIONS!




Let’s get to know Scratch!
WEe'll also learn about sprites
and coordinates.

3OVLS

To follow along with the Secret Manual,

you first need to open Scratch. Once you
Create a new project, you'll see Scratchy
the cat on a white backdrop. The cat doesn’t
do anything yet because he doesn't have any
programs. Scratch calls Scratchy the cat—
and all the other characters and objects we
add to a project—a sprite. Soon, we'll start
giving him directions to move by using the

blue blocks in the middle of the screen. )
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You'll need to give each sprite its
own instructions. In other games
we play, we'll have more than one
character to control, so we'll have
more than one sprite listed here, in
the Sprite List. To give a particular
sprite instructions, click a sprite in
the Sprite List first and then drag ek
blocks into the Scripts Area.

tion style left-right

BREAKING THE SPELL!

We need to get Scratchy the cat
moving again. We'll make him
dance across the Stage.

F . Scripts Costumes Sounds

The command blocks you

can give a sprite are here.
We'll stack these commands
together to break the magic
spell and get Scratchy back on
his feet. The blocks here are
all blue, as they're from the
Motion palette.

/

>

Saved [E nostarchv

gjj G

x 0
y:0

Jo

To move a block, just click and
drag it over here. This is called
the Scripts Area. It's where we
write our programs.

—
"
2

Now let’s take a closer look
at the rest of the interface...




A Guided Tour of the Scratch Interface!

Sprite Toolbar
Contains the

Play the Give your Duplicate, Delete,
game full project a Grow, Shrink, and
screen. new name. Block Help tools

Palette

Each of these ten buttons lets you choose
functions (called blocks) for programming your
sprites. You can combine these command
blocks in stacks to create programs that
control objects on the screen.

! ]

7

5 [Untitied-1
w21z bynostarch (unshared)

~ e

Ikas lCuntruI

Stage I souna  sensing
I ren [ operators

Dlsplays your creation J pata [ More Blocks

point in direction €8

The green flag starts the
game and the red flag
stops the game.

point towards

go to x: O y: O
ge ko mouse-pointer

LREIS S oide ) secs to < O v: O

New sprite: & / a5

Sprites

change x by €D

set x to
change y by €D

set v to @

Sprite List it sl noemen
Here are the characters
and objects you've created,

lgll x position

including the Stage itself.
Click the icons to edit each

Scripts Costumes Sound;
[oion — | 8 v

Scripts Area -
Here's where you build your
programs. Stacking blocks
together here lets you control
the sprites in your project. Click
one of the three tabs at the top
to change to other functions:

Scripts: Allows you to

drag command blocks from
the Palette and put them
together to write a program

Costumes: Allows you to
draw, import, or edit images
for a sprite

Sounds: Allows you to record

or import sound files for a
sprite to use

sprite individually.

Backpack A

New Sprite Buttons

There are four ways to add a sprite:

e Pick one from Scratch’s built-in library

e Draw a new one

e Upload an image you already have

e Take a photo with your computer’s webcam




Sprite Information
You might have noticed a little blue i in the corner of the box around
Scratchy when you select his sprite in the Sprite List. Try clicking the i,
and you'll get information about that sprite.

This section shows the sprite’s name, position, and direction it is facing
(the little blue line).

30OVYLS

This is how you can rename the Scratchy sprite.
Right now it's Spritel. Don't you think that's a
little boring? Try renaming this sprite.

‘ o
\ 1.
Sprites New sprite: ‘@ / & 3
|.Supreme Cat #1
x: 0 y: 0 direction: 90° =
(rotation style: U o) k
caff drag in player: [ ‘
shfow: BR
\
1
Click this arrow when Rotation Settings Try clicking and
you're done with the You can control how a sprite dragging the little
Sprite Settings pane. rotates in three ways: blue line—see what
We'll play with these e Can rotate freely happens to Scratchy’s
other settings later. ‘ e Can face only left or right orientation.
e No rotating allowed
4
Now, onto the fun stuff. To use Scratch to program il 5 N Wi
movements, you first have to understand how B [backdropt
Scratch positions things. h/aB
1
Click the Stage icon in the Sprite List. Switch to o \
the Backdrops tab in the Scripts Area and choose 2 backdrops
Choose backdrop from library. New backdrop: backdrop1 -
E/an L=
Note: Sprites have costumes while the Stage has [ ]
backdrops.
4
Choose Backdrop Library
the xy-grid W
backdrop and
click OK to All L.
use it. It's in Indoors @ @
the “Other” Qutdoors - o/
category. Otfsx Xy-grid -




Now you can see exactly how Scratch positions objects.
Everything is on a grid with two axes:

y-axis: A vertical line that marks up and down positions;
ranges from -180 (lowest) to +180 (highest)

x-axis: A horizontal line that marks left and right positions;
ranges from -240 (farthest left) to +240 (farthest right)

Scratchy’s default position is at the point where the x-axis
and y-axis meet. His coordinates are (X: 0, Y: 0).

Now we can program movements for
Scratchy the cat! But first, try dragging
him to the top of the Stage, as shown
on the right.

Note: The bottom-right corner displays
th}e coordinates of your mouse. This (xe-240.4:0) (:0,9:0) (x:240,%:0) =
will be really helpful when we start r ]
setting the positions of sprites!

The current coordinates of a sprite are
shown in the upper-right corner of the

Scripts Area, too.
0P | (x:0,¥:-180)
o ¥. 125

x0
¥ 125

Scripts Costumes Sounds

| wotion [ S8
ILooks IControI
ISound ISensing
IF'en IOperators

Data More Blocks
i i

box at the bottom left of the screen). Switch to
the Scripts tab in the Scripts Area and then
click the Motion palette button. Click and drag point towards V4
out the command block to the ’

Scripts Area. ) ’

lnnvemsteps
To make sure we're giving Scratchy the cat
: i S o2 S0 rn ) €D degrees
instructions, click him in the Sprite List (the secte0
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>
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that simple.

Click the number of a coordinate to change it. Set x to 0 and
set y to 125. Now click the block to run it! Scratch goes right
to that position. We've just written our first program! It's really

We want Scratchy to move
around, but at the moment, he
moves too fast for us to see! To
make him move more slowly, click
the Control palette and drag out
the command to the
Scripts Area. Make sure to drag it
under your blue command block.
Wait for a white line to appear and
then release the mouse.

go to x: ) y: €D

The two commands are joined
together! Now change the time
to 0.1 secs.

Tip: If you want to separate the
commands, simply drag away

the block. If you want to delete a
block, simply drag it back to the
palette. Give it a try. To move a big
stack of blocks, click and drag the
topmost block in the stack.

>

Scripts Costumes Sounds

IEvents

| Control |
ISensing
IDperators

| ore Blocks

Next, select the
Duplicate button on
the Sprite Toolbar
and stamp it on the
commands to make
five copies.

go to x: O y: €D

e
go to x: EE) v: ED

-




Type these coordinates in your
own program, so it matches this
picture. When you're finished,
click the whole command block
to make Scratchy jump around
in a pentagon shape!

To make him move in a loop continuously, drag out the
command block from the Control palette and place
it at the top of the code. Click the block, and it will actually
run! Click to stop Scratchy from moving around. You can
test any program in this way—just click it with your mouse.

Tip: Whenever you're writing scripts, you'll want to test them
every now and then to see if they work the way you expect.

go to x: ED) v: EED
go to x: G y: CED

giide (X secs to x: €D v: €D

Now let's make Scratchy glide around instead of
jumping from point to point. To do this, click the

glide (XD secs to x: ETD v: EFD

Motion palette, drag out five commands, glide (D secs to x: O v: @D
and join them together. Follow the picture on glide BV secs to x: €D v: EED

the right, and copy the seconds and coordinates. glide (XD secs to x: EED v: ED

Once you're finished, click the script to see the
results!

Now we can join these two programs together! From

the Events palette, drag out the
command and put it at the top of your two scripts.

Tip: We'll often need multiple scripts to start at the

same time, and using the command
will help us do that.

>

'l_lﬂ to x: EED v: €D
weait CED secs

gide @ secs to x €D v: €
glide (ED secs to x: €D v: EED
' gide XD secs to x: O y: €D

" giide @) secs to x: €D v: €ED
- D ©




Because we used the command, we
can use these buttons above the Stage to start (/) - ®
and stop (@) the game.

& ot KK

3OVYLS

Next, click the Pen palette
and drag out the four green
Pen blocks shown on the
right. Now when Scratchy
moves, he'll draw a magic
star web!

Scripts Costumes

| motion J Events
ILooks IControl
ISound ISensing
m IUperators
I Data I More Blocks

(¥:-240,¥:0)

set pen color to

change pen color bv'm

set pen color to 'ﬂ

change pen shade Ivv'm

set pen shade tom

change pen size by o

Tk

set pen size tno

(%:0,¥:-180)

Sounds

set pen color to

set pen size tnm

go to x: €1 y: €D

r.;tmm

gﬂeﬂ'sers to x: ‘E:’

3

glide (XD secs to x: D v: EED
13

gﬂem::ers to x:ﬂv:@

 glide (XD secs to x: G v: €D
BT

Occasionally, when you run your program,
there is a software bug. This is the most
exciting part of computer programming:
discovering an error in something you
have made and then solving the problem.
In this case, sometimes Scratchy will
draw an odd line at the beginning of the
program.

If we drag Scratchy anywhere else on

the Stage and then press /M, he draws an
extra line because he starts in the wrong
place. Try doing this multiple times to see

if you can spot the bug. )




(¥:-240,Y:0)

This software bug can be fixed by adding
some more code—that is, new blocks—to
your program. In this case, simply place

a new block (from the blue Motion
palette) above the green Pen blocks and

below the block.

With this little correction, Scratchy will
always begin drawing from the correct
position in the grid. The bug is gone!

vy [(%:0,¥:180)

¥

(%:0,¥:-180)

(%:240,Y:0)

set pen color to

set pen size tnm

go to x: EED v: €D
rﬂtmm

gmmmm x: EED v: €D

' glide (XD secs to x: €D v: €D
' glide @) secs to x: O v: €D
Pl_lliliEﬁ!)-fnzrs to x: D) v: EFD
' giide G secs to x: €LD v: €

Let’s add a whole new program to
make a magic star web that changes
colors. Build a second stack of blocks

that uses the

command and see what happens.

Isn’'t that cool? You can give a single
sprite more than one set of blocks!
Scratchy now has two programs. This
tiny second program sure makes a hig
difference in how the game looks.

-ch.ange pen color bvo




GERE © o ety Tips

New

Save now
Save as a copy
Go to My Stuff

B
P e[~ Ter - My SweetSaatch projcts = [E83)[ search My SweetScratenPro;

Organize ~  New folder E - @

Upload from your computer

Name - | Date madifed | rvpe ES |

Download to your computer co
3 Libraries

Revert
T £y & Hmegron

18 Computer

Mo items match your search.

€ Network

Remember to save
this file so you can
play with it later! ————

2 tide Folders|

If you are logged into Scratch, the website stores all of your projects into
My Stuff so you can easily find them. The website saves your progress
every so often, but you can save manually too: File » Save Now. You can
also save different versions of your programs to make sure you don't lose
older versions of your games and can safely experiment—File » Save Copy
creates a new version of your project in My Stuff. If you want to download
a version for yourself, try File » Download to your computer. Then save
it in a safe spot!

>

Scratchy’s Challenge!!

Can you edit this program to make Scratchy draw
different kinds of shapes? Give it a try!







STAGE

MAGIC
STAR WEB!

NICE WORK!
YOU'VE BROKEN
THE DARK
WIZARD'S SPELL!

MY NAME IS
GOBO. IM
A COSMIC

THAT SOLAR
DEFENDER!

FLARE
DESTROYED
THE BALANCE
BETWEEN THE
DIGITAL WORLD
)\ AND THE REAL
WORLD!

ALRIGHT! I CAN
FEEL MY LIMBS
AGAIN!

WHO ARE
YOU AGAIN?

THIS UNIVERSE 1S
NOW CONTROLLED BY THE
DARK WIZARD AND HIS MINIONS.
THEY FROZE ALL THE COSMIC
DEFENDERS BESIDES ME—

AND ALL THE HUMANS
. ON EARTH.

32



THIS SECRET

\/ MANUAL SAVED

US. MAYBE
IT CAN HELP
OTHER PEOPLE
AS WELL!

OH NO!

MY FELLOW
DEFENDERS ARE IN
TROUBLE! CHANGE
INTO A SPACE SUIT

AND SAVE THEM,

KIND FELINE!

BY THE WAY,
GOBO, MY NAME
IS SCRATCHY, AND
HE'S MITCH!

GREAT IDEA!
YES! IF I LEARN YOU CAN DESIGN
TO PROGRAM, IT NEW EQUIPMENT AND

MIGHT HELP TO EVEN CONTROL OUR
DEFEAT THE DARK MOVEMENTS!

WIZARD!

WE NEED THE
ENERGY FROM SEVEN
ALRIGHT! DIMENSIONAL STRINGS

BUT WHY DOES
SCRATCHY NEED TO o::g ggi c‘ﬁﬁ,@m&
THE SPACE SUIT?

FRIENDS...

..BUT INSIDE THE
VORTEX, THERE'S NO

| OXYGEN, AND LIGHTNING
CAN MAKE THINGS
DISAPPEAR!

WOW! IT'S FULL
OF STARS!

THE ADVENTURE INTO
SPACE BEGINS...



A SPACE ODYSSEY!

Learn to design new costumes Avoid the lightning bolts and

and program a sprite’s move- collect seven dimensional strings.

ments, reactions, and sound Once you've got them all, the
STAGE effects. Monolith will appear!

To make things really easy, let’s start by opening
a blank project called 02 - A Space Odyssey.sb2.
This project has all the sprites you'll need, but
none of the programming yet. To open a file, click
File » Upload from your computer.

Upload from your computer

Download to your computer
Revert

But let's try making some sprites of our own, so
you can make changes to this game's characters
and invent your own games, too! Click Scratchy’s
sprite icon in the Sprite List, and then click the
Costumes tab. You'll see the Paint Editor—just
be sure to click the costume you want to change.

At the top of the Paint Scripts | Costumes | Sounds m
Editor, you can give your “;“’;E”’; [Scratchy CM Clear gl
Costume a name. We =
can then reference the ; = &
costume names in our W%a; R
programming. el -

&Bx114
If your Paint Editor L
looks different, it could , T
be because you haven't S
opened the blank project = &
file (02 - A Space Odyssey &
.sb2) that has Scratchy’s -
astronaut costume. i

-+

Scratch has two modes
for editing graphics—

on the right is Bitmap
mode. See page 38 to
learn more about editing

in Vector mode. A RUISIS

200%

Bitmap Mode
Convert to vector



Here's where all the tools
are. The Brush and Eraser
tools make it easy to draw.

n o Clear ENES

The Eyedropper tool will
match the current color to any
color you click in your image.

I

Scripts Costumes Sounds
New costume: |'S Lichy
d/ad v
; &
Astro-Cat | |
3x114
®
92 T
Scratchy Y \
B5x111 &
Use the Fill tool to color big =4
parts of your drawing at once. !
You can choose a single color 1
from the palette or use a
gradient effect from the Tool
Options.
0

. HEN /

[ ]
=IIIII==

Bitnfap Mode
Coglvert to vector

/

Whatever tool you are using, the options
for the tool will appear at the bottom of
the Paint Editor. For example, the size
of the Brush or Eraser can be adjusted
if you want to make a big drawing or
add fine detail. Just click and drag here
to pick the right size.

Tool Options

You pick a color for your tool here, too.

Click the Zeom buttons (the magnifying
glasses on the bottom right) to zoom in
or out on your creations. This will make
it easier to draw! Clicking the equals sign
(=) shows you exactly how your sprite
will appear on the Stage.

If you're not sure what a button does,
simply hover your cursor over it, and a
description will appear!




STAGE

You also have tools to draw rectangles and ellipses.
Can you give Scratchy a stovepipe hat like Abe
Lincoln using the Rectangle and Ellipse tools?

ofa/ &+

These shapes can be empty inside
or filled in. Try experimenting with
different colors for the inside and
outside. If you press the SHIFT key
when you start to draw, you'll
’) have a perfect circle or square!

(You can also use this SHIFT trick
a when using the Line tool to draw

a straight line.) Try rotating your
shapes using the handle on the
top of the box.

NI A

Q= Q

400%

Bitmap Mode
Convertto vector

ofo/ (& 1+

3
i)
o

]
The Text tool lets you add Mpo)

writing to your sprite. We'll
use this tool when we need
to give the player instructions
for our games. If you want

to move the text, simply click
and drag the black box that
surrounds your text.

REIT - DN

This is cool!

Q= Q

200%

Bitmap Mode
Convertto vector




Scripts | Costumes | Seunds [ snare | 49 seeprojectra

New costume:

[Scratchy o Clear ol =+
d/an
) &
Astro-Cat =]
Fren

[ ]
T
T &
&

o — R 5 <o oriect o
Newmﬁ"“me‘ | scratchy 5™ Clear o =+
d/anm
) 4
Astro-Cat =
saxi1e
[ ]
4 T
T &
&
oy
oL

e ] 65 soepoecond
o &+

To use the Select tool, use your
mouse to create a frame around a
certain area. Then you can do all
sorts of things to the selected part
of your costume:

e (Click and drag the selection to
move it to a new location.

¢ Resize, smush, or stretch the
image using the handles on the
sides of the box

e Rotate the selection by clicking
and dragging the handle at the
top center of the box

e Press and hold the cTRL key and
C key at the same time to copy
the image area (Mac users can
use 38-C instead). Then press
CTRL-V to paste your selection,
as many times as you like.

e Press the DELETE key to erase
the selection.

The Set costume center
button marks the center of
your sprite. This helps to
make sure your sprite doesn't
end up in the wrong place
when it spins or rotates!

[sar ] 5 soeroscoo

.S
o =+
Set costume center

By using the Duplicate tool,
you can copy and stamp a
selected area as many times
as you want! Just draw a
frame around the area you
want to copy and then click
wherever you want to paste.



STAGE

Vector Mode
Hew costume:

You may have noticed that s/ 8@
when you edit other sprites in :
Scratch, you don't see the same \%
Paint Editor tools. Some newer fzit
sprites are vector art—that’s just el

a fancy way to say they're made ]
of shapes, instead of pixels. e
Vector art have small filesizes, Seratchy
but they are great quality—and
they can be resized without

losing quality.

=)
Note: For simplicity’s sake, all

— of the graphics in this book use

— Bitmap mode. But your custom
projects can use a mix of vector
and bitmap graphics.

|Space Crab

Space Crab
13481

You can switch from Scratch’s Bitmap mode (the
one seen earlier) to Vector mode by clicking the
Convert to Vector button at the bottom right of
the Paint Editor. The difference between using
these two tools in Scratch is like the difference
between Adobe Photoshop and lllustrator—or
GIMP and Inkscape. Use whichever Paint Editor
mode you like the most!

You can import SVG files into Scratch’s vector
editor. In Vector mode, you can squeeze and
shape lines, reshape, and ungroup. Here's how
the Vector mode works.

Scripts Costumes Sounds

n @ Clear o a4+
=
a3
i
N
o
O
T
e}
£
=5
=1
..
QA=Q

[ share | 6% see proctpag
ol &+
Select object— &3
Reshape a line or shape—*

200%

Vector Mode

Convert to bitmap

(click on an object, then | # — Pencil
drag its round “handles”) [~ — Line

Rectangle—

Text— T

a .
o —Ellipse

& — Fill tool

Duplicate—*

Forward a layer—1
Back a layer—T

Ungroup™ 1 *

w 4]



Try opening a vector
graphic from Scratch’s
library, and give editing

one a try butterfly3 cat1-a cati-b cat2
b
N e
dinosauri-a dinosaur1-b dinosauri-c dinosauri-d

The Backpack

Here’s a cool new feature. If youre logged into the
Scratch website, you'll see something called the
Backpack at the very bottom of the screen. Click it,
and it'll open up. Yours will be empty until you throw
some sprites in it.

Backpack @

Backpack v
B =
Sprite Sprite Sprite Sprite Script Script
Side?Side Lightning Whiptail Magic Gem

Your Backpack lets you share sprites and
scripts between projects. If you play a really
cool game on the Scratch website and want
to use the character in an entirely new
project, just click and drag the sprite right
into your Backpack.

©V© When you create a new project of your own,
just open the Backpack again and drag the
sprite out. You can write all new programs,
or use the ones that were already with the
sprite. You can even use your Backpack to

store programs you want to reuse!

ls

L/ \J

dinosauri-e



STAGE

Once you know how to use the Paint Editor’'s
tools, Scratchy can put on his space suit!

Go ahead and draw your own, or use the
costume that’s already in the project.

Because we've selected the horizontal
rotation style (circled below) Scratchy will
face only left and right.

Sprites

Stage
1 backdrop

MNew badedrop:

a/an

New sprite: ‘@ / & 3

|. Astro-Cat

x-15 w32 direction: -90° ==
rotation style: 0 £
can drag in player: [

show: B

Now we have the main
character for our game:
Scratchy the astronaut!




Next, let's take a look at the other

sprites in the game. You can use the New costume:

art that's already in the game, or d/aB

draw new artwork yourself! Click ./ T

to draw a new sprite. @
String
AGucdd

First, take a look at the String and

the Monolith. They are two costumes

for the same sprite, String. If they Monolth

were two separate sprites, we'd have =k

to write two programs. But now we

can make this sprite switch costumes

and write only one program.

(A
Now for our third new sprite, some
scary Lightning! The player will need New costume:
to avoid the lighting. d/am
Lightnin
G272
S
We also need some instructions to
appear at the start of the game. We'll
call this sprite Banner.
a N

New costume:
d/anm

1

Banner
A0Z335

Scripts Costumes Sounds

|. String

\
|
o
T
&
&
ish
e

Scripts Costumes Sounds

|.Lightning

EQ =001 7

Scripts Costumes Sounds

|.Banner



STAGE

Next, let's look at the Stage.
| used artwork of a black hole
from NASA! You can draw a
new backdrop if you like. Click
the Stage in the Sprite List, and
then click the Backdrops tab.

Scripts Backdrops Sounds
H backdrop: P —
o C+ s [Ouasar n @ Clear bl gﬂ +
e/
|
&
s
i
[ Pl LY a=q
[ ]| 100%
HE ENEEE
HE HE Bitmap Mode
.‘ T TT]
0 - EEEEEEEE Convert to vector

Now that we have a bunch of sprites for the
game, you can see how everything appears in
the Sprite List. To give a sprite new instructions
or costumes, you'll first have to click it in the
Sprite List. Let’s start by giving Scratchy the
astronaut his programming.

Let’s write our first program @ for Scratchy! Make
sure he’s selected in the Sprite List and you've clicked
the Scripts tab. His first program is a short one that
makes him bounce up and down a little. This makes
him look like he’s floating in zero gravity!

Astro-Cat




For program @, we'll make a conditional—if something

is true, then something else will happen. In the Control
palette, drag out an f&j block. Then for the diamond shape,
drag the Sensing block [EIINTTEETE. Right below
the . put what you want to happen when the statement
is true. Drag out the rest of these commands to form the
complete program. Now you can move Scratchy up, down,
left, and right by using the keyboard!

~ | Now we'll give Scratchy two more programs. We'll need to
- R s ] program them individually, and then use [T INENEEEET]
change y by €5 to make them all run at the same time.

.

-_ key left arrow prﬁsed'! l]nnn
i point in direction
s
change x by &5

.key right arrow  pressed? IIIEII

point in direction m
»

Let's write programs © and @. Click the Control
and Looks palettes and drag out these commands.

Program @ controls which costume Scratchy
wears, and program @ makes Scratchy become
invisible like a ghost each time he gets struck by
lightning.

When you've finished all of this, Scratchy’s
programming is complete!

Next, let’s click the Banner sprite.
We just need a simple program to
make these instructions appear at
the start of the game. The
loop using the and blocks
makes our instructions flash, so the
game is even more exciting.
—_— >




STAGE

(Y

Now we can add sound effects to the game!
I've already added a few, but you can change
things up. First, click the Stage in the Sprite
List. Then click its Sounds tab. You can create
whatever kind of sounds effects or music you
like for your Scratch projects. You can even
record your own sounds right in the Scratch

Scripts Costumes Sounds

New sound:

< & @
program.

If you click the Record button, a sound recorder will pop up.
You can click the round button to record speech or sound
effects through a microphone. When you're finished, click OK.

Note: To record your own sounds, you'll need a microphone
attached to the computer. To listen to sound effects and music,
you'll need speakers.

Scripts Costumes Sounds

New sound:

€ a

1
e
LR

|recording1 H o

recording1

00:00.0

ity v
b ] Y Edit Effects

Microphone volume: 0

If you want to use sounds that are prerecorded, you can press
1§ to use Scratch’s sound library, or g} to choose files from
your own computer (MP3 and compressed WAV, AIF, and AU
formats are supported).

Sound Library

ar o o e i e e i €

Animal afro string alien creaki alien creak2 beat box1 beat box2 bell toll bird bubbles
Effects
Electronic

Huran e e e e e ' e '
Instruments < » Ll K2 Ll K 2 < » {z » {z » s » iz »

Music Loops computer beeps2  cough-female cough-male cricket crickets cymbal crash dog1 dog2

Percussion
. . . ” o ” . ”
> Wi wWiEr wE> WE» Wt r gt Wt »

Vocals
drum set2 drum duck eggs fairydust finger snap footsteps-1 garden

iz » < » iz » < » i< » i< » iz » i< »

hand clap hip hop horse gallop horse human beatbox1 ~ human beatbox2 jungle lasert
. . » . . ” . ”

> WEr wWiEr» wE> wWE» i r gt Wt »

medieval2 meow meow2 motorcycle passing owl party noise plunge pop

A= T 4 = A= A T .4s

oKk || cancel




Now we can add some simple programs to the
Stage. Program @ makes its backdrop change
colors. In program @, use the Sound palette
to add a song to the Stage.

switch backdrop to Quasar

Scripts Backdrops Sounds @ Q‘) See project paq

N d: L —
o | Technot )| e

W& a ) change color  effect by E5)
1 | ”
’
<
Technot

> H @ EditY Effects ™ bset volume to EI) o6
play sound Technoil until done

Microphone volume: O d

Next, we can add some sound effects to the
String and Lightning sprites to make the game
more exciting! Test how you like my sound
effects, and make your own if you like.

Scripts | Costumes | Sounds m 4% See project pad Scripts | Costumes | Sounds w &Y See project pag
New sound: A Hew sound: S —
5 4 |Hummmg n o / ' \Thuntler n o
(LR - ; i a
1 T 5
e s
< (<
Humming Thunder
00:00.7 00:01.7
v R ity v
» H e Edit Effects » H e Edit Effects
Microphone volume O Microphone volume: (O

You can record a sound yourself and
then change it using the Effects menu.
Try reversing what you record to make
it sound really weird!

Click the Lightning sprite, and
write a program so that whenever
Scratchy touches a lightning bolt,

..setunlmtnmib
3

play sound Thunder wntil done

a sound will play.




STAGE

The Lightning sprite needs some more
programs. Go to the Control, Events,
Looks, and Operators palettes and
program these commands to have the
lightning bolt randomly grow bigger

or smaller, making the game more
magical.

Next, write this program to make the lightning
disappear whenever Scratchy touches it and to —— :
control the way it moves. [_“il pick random () to €K} |secs

go to x: | pick ra'ulnlrnmtn v:m

The lightning’s vertical position (y-axis) changes 'gn e

because we repeat eight times the subtraction of
40 steps (-40) from its original y-coordinate of 260.
To make the lightning move differently, you can
change and play with these numbers.

So that the lightning bolt makes Scratchy disappear,
we must make sure that each time it moves—that
is, the position of its y-axis changes—the program
will check if it touches Scratchy.

Tip: Sometimes when you've used
the and blocks, a sprite
can disappear while you're working
on the program—running it, testing
it, and checking for bugs. Simply click
the block in the Looks palette
to make the sprite appear again.
(You can also check the show box

in the Sprite Information pane.)

>

& e -,



Now it's time to program the String sprite.
Make sure you click it in the Sprite List first!
Program @ makes it change color, just like
our Stage. Program @ will give it a simple
animation, using the fisheye effect.

dear graphic effects

change color effect bve

-l:hange fisheye
change fisheye
change fisheye

change fisheye

Now for a big program. Let’s start oyl i

by dragging out the blocks you can
see in €. These will control how the
String costume spins and moves.




Then add to your program so that
it looks like @. This will make your
dimensional string appear in a
random place on the Stage seven
different times. The B blocks
and blocks at the end
of the program make sure the
player knows he has grabbed a
dimensional string.

- until  touching Astro-Cat

change y by €9

set volume to@ﬂb
3
play sound Humming

L0.2)

We're not done yet!
This is a hig script.




Add a [[YTEINEETEY block at the top of our script

and some instructions at the very bottom so that once
Scratchy has collected seven dimensional strings, the
String sprite will change to its Monolith costume. When
that happens, the player wins the game. Make sure
your finished program looks like ©.

switch costume to String

3
set volume to E g
3

play sound Humming

switch costume to Maonolith

=18 Stargate opened! f378 a secs

Now you're done!
Nice work!




4 After saving the file, you can enjoy your final
creation! Make the Stage full screen and
click /™ to begin a new round.

Scratchy’s Challenge!!

Add more lightning bolts to give yourself a
challenge. Or you could replace the lightning
bolt with a big, scary space monster you drew
yourself! Give it a try!
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THERE'S NO HOW
TIME TO SIGHTSEE! A DEVIOUS!
WOW, PARIS 1S COSMIC DEFENDER :
BEAIUTIFUL' HAS BEEN TRAPPED IN
° MONA LISA’S SMILE!

THE STARGATE
BROUGHT US TO
PARIS...LET'S GO
TO THE LOUVRE

MUSEUM!

THE
PAINTING'S IN
THERE! RATA! BETRAYER!
1 CAN'T BELIEVE
YOU'RE HELPING
THE DARK WIZARD
Now!

HOLD ON NOW.
*DUFF PUFF* WE DARK MINIONS
I SHOULD'VE TAKEN WON'T LET YOU IN
OFF THIS SPACE SUIT SO EASILY!
BEFORE RUNNING.

HUMPH! NOW THE
ART 1S MEANT , EAINTIN@ HOHLDIN@
FOR SHARING. YOU y YOUR FRIEND HAS BEEN
| NAI:FII:i {'ErHvs oArfljp CAN'T TAKE IT ALL S . CUT TO BITS! TAKE ON MY
FOR YOURSELF! i Al . CHALLENGE AND THEN
15 MINE NOW! ‘ S a SR WE'LL TALK!
*HEE HEE* ,
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THE LOUVRE

©0000000000000000000000000000000000000000000000000000000000000000000000000000000000

Let’s learn how to control
the flow of a game. You'll

see how to keep score
using variables and con
the order of the game
using broadcasts.

trol

This game is actually two games in
one. First, you'll face Rata’s quiz.
Then you'll have to put the Mona
Lisa back together in a puzzle game.
If you get the answer wrong three
times, the game ends and you lose!

©000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

This program has some tricky custom graphics.
So let’s start out by opening a blank file called
03 - Louvre Puzzle.sb2 (File » Upload from your
computer), which has these sprites in it. Take a
look around. You can see that the Stage has a
backdrop that shows the Louvre. We just don't

have any programs ye

t!

Scripts Backdrops

New backdrop:

/B

[Lnuvre

|

like how it sounds!

Then we'll add a program that
) makes the Stage play music.
The block is a special
Sounds kind of command we call a loop.
Any sound effect or music you
add here keeps playing again
and again, so make sure you

MNew sound:

i & Q@

1
e
iz
Xylo2

00:11.4

>

Photo Credit: Raphael Frey

until done
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Now click the sprite for Rata, in
the Sprite List. Make sure you like
how he looks. Since we selected
him, now we can give him some
programs!

Scripts Costumes Sounds

New costume:

d/aB

[Rata

128x123

Write program @ first.
This loop makes

e mg—— Rata float up and down.

[~ >
-iitmserj

¥

change y bye
[

For program @, go to the Looks, Sensing,
and Operators palettes, and use the and
blocks. This program asks the first question
of Rata’s quiz. We've made it a multiple-choice
guestion, so the answer must be A or B.

ask [TPPTAPIE and wait
E=VN See if you can answer my questions, foro_r-ers

say | answer fnrOsers

EX 4 Who painted "Mona Lisa"? (A} Leonardo da Vinci (B} Ludwig won BEEEhOVEnm

if =

broadcast question2
| = -

stop this script
3

if

say EIVEPETH for € secs




If you noticed back in program @, Who painted
there’s a command that says {Monaltisa’ 1 (A).
question2 if you get the right answer. - B (2),Lucwig von
Broadcasts are like big announcements

to all the programs in your project.
They're a great way to connect related
parts of a game. So let’s try writing two
more questions as new programs ©
and @. These two programs wait for
broadcasts question2 and question3 to

start using the block.

e when I receive guestion2

4] Madrid, Spain [B] Flarence, Italym

broadcast question3

this script

)

3
broadcast puzzle
| =

stop this script

When the player answers all
three questions correctly,
the puzzle broadcast signal
in program @ tells the game
that the quiz is over and

the puzzle half of our game
should now begin.
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Now take a look at the Puzzle sprite. This
isn't just a single image—it’s a sprite with a
bunch of costumes. The sprite’s costumes
include instructions for the player, as well
as the puzzle itself!

The final two costumes display the winning

screen and the message that appears when C

you lose.

Let’s take a closer look. First,
we'll display the costume that
shows instructions for the player.

Memorize the
picture sequence!

¢
.
y



o

Then we'll display the four E

parts of the Mona Lisa. These \
costumes display the sequence
that players have to remember © )
to win! :
\_—_. J \. Y,

start screen.

The next three costumes display Repeat the SequenCe
more game instructions and a
e J correctly!

(= Press The Right Button! A e 2)

f :

\ Start Now!!
« 2
=

Finally, we have
two costumes for
the winning and

YOU WIN! losing screens.
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For this big sprite, we'll need a lot of programs. Let's start by
adding a special kind of command called a variable. Variables
are good for keeping track of numbers that change during a
game, like scores, player health, player lives, and more.

Click Make a Variable in the Data palette, and call it Chance.
The new Chance variable is how the computer knows how
many times the player gets another chance to solve the puzzle

before losing.

>

Scripts Costumes Sounds

I Motion I Events

I Looks I Control

I Sound I Sensing
I Pen I Operators

Make a Variable

New Variable

Variable name: |Chance

@ Forallsprites () For this sprite anly

Cloud variable (requires sign in

oK Cancel

Scripts Costumes | Sounds

I Motion I Events

I Looks I Control

I Sound I Sensing
I Pen I Operators

ta [ wore Blocks

Make a Variable

4
E"

set Chance to m

change Chance Iw'o
show wvariable Chance

hide variable Chance

Make a List

Now for the programs themselves.

Add scripts @ and @. Script @ just
hides our variable Chance during the
quiz part of the game. Next, script @
determines how the Puzzle sprite should
change costumes—just as described on
pages 56-57. After it's done switching
costumes, it broadcasts start.

hide wvariable Chance

when I receive puzzle

go to x:@v:@

show wariable Chance

switch costume to instructions1

maonalisal

monalisa2

monalisa3

monalisad

instructions2

switch costume to armow_key

switch costume to

broadcast start




Then we'll add four
different scripts: one

for each right answer to
the puzzle. If the player
presses the wrong arrow,
the sprite changes its
costume and a broadcast
called wrong is broadcast.
WEe'll use this broadcast
to control the Chance
variable.

Tip: You can use the
Duplicate tool (E¥) in the
Sprite Toolbar to save
some time dragging out
blocks.

Notice how the broadcast
named 1 at the end of
script € starts script @.
Likewise, script @ starts only
3, which is
broadcast by script @ when
the player presses the correc
arrow. With all of the correct
arrows pressed in script @,
we signal a new broadcast
called win.

when I receive start

¥

-

if

if

if

if

if

if

key uparrow  pressed? . then

switch costume to monalisa3

b
say [EFRN] for €) secs
b

broadcast wrong

key downarow pressed? . then

switch costume to monalisa4

i
say I For €9 secs
»

broadcast wrong

key leftarrow  pressed? | then

switch costume to monalisal
»

say [SNEE for € secs
13

broadcast 1
=

stop this script

key right arrow  pressed?  then

switch costume to monalisa2
»

say SR for @ secs

s

broadcast wrong

key up arrow  pressed? . then

switch costume to monalisa2

b
= e
b
broadcast 3
3
stop this script
key down arrow  pressed? _ then

switch costume to monalisad

b
say I for @ secs
b

broadcast wrong

key leftarrow  pressed? . then

switch costume to monalisal

b
say S0 for € secs
3

broadcast wrong

key rightarrow  pressed? _ then

switch costume to monalisaz

i
sy 2N for € secs
{2

%

[*

b
3

if

b
3

if

b
3

if

b
3

key uparrow  pressed? _then

switch costume to monalisa3

say [EIE] for € secs

broadcast wrong

key down arrow  pressed? . then

switch costume to monalisad

say [T for € secs

broadcast wrong

key leftarrow  pressed? . then

switch costume to monalisai

say X1 For € =ec=

broadcast wrong

key right arrow  pressed? . then

switch costume to monalisa2

say [SNEE] for € secs

broadcast 2

*

if

if

if

stop this script

key up arrow  pressed? | then

switch costume to monalisa3

b
savfnrOsers
v

broadcast wrong

key down arrow pressed? then

switch costume to monalisad

»
say [ for €9 secs
3

broadcast win
®

stop this script

key leftarrow  pressed? _ then

switch costume to monalisal

b
say [0 for @ secs
b

broadcast wrong

key rightarrow  pressed? then

switch costume to monalisa2

b
savfnrOsers
b



Finally, add three more programs to the
Puzzle. Program @ subtracts 1 from the
Chance variable any time it receives the wrong
broadcast. Programs @ and © control when
the winning and losing screens appear.

switch costume to menalisa_win

That's it! Remember to save
your project, and then give
the game a try. Let's see if
you can win this!

= 8 I &

Scratchy’s Challenge!!

Can you use the FH% block and broadcasts to create
a personality test? How about a flash-card game to
learn words in a new language? Give it a try!







ISSION
CCSAMPLETED! FABU'S FREE *SNIFF*

FOILED AGAIN...

AWW...DON'T BE
UPSET! I JUST THINK
THAT ART'S MEANT TO
BE SHARED!

OH NO! BUT IF
DO YOU THINK THE PROBABLY! BUT BE THAT HAPPENS, THE

COSMIC DEFENDERS CAREFUL NOW. NEWS
woltp menesnce. |l ST AT
IF I APOLOGIZED? WIZARD IS PLANNING TO DESTROYED!
: LAUNCH A VIRUS ATTACK
ON HONG KONG!

(&N

, . HONG KONG i R STAND BACK.

W HAVE T A I R e I KNOW KUNG FU!
DESTROY THE VIRUS " [ s

RIGHT AWAY!




HACK ATTACK

metame—— 0 ALIE

Learn to control sprites Help Scratchy attack flying

with the mouse, program viruses and stop them from

objects to bounce back, and touching the server at the

start a game by pressing the bottom of the screen. If you
® spacebar. successfully block 30 viruses,

you win the game!

Scripts Backdrops Sounds

q N backdrop: f
S ac* i [HongKaong
-/ B
: &
»*
HongKong ||
4800180
Y

Let’s start by opening the blank project
04 - Hack Attack!.sb2 (File » Upload
from your computer). | used a sparkly
photo of Hong Kong's skyline as my
Stage. You can use whatever you like!

when I receive start
dear graphic effects

. o]

(2
Did you know you can add JT_J
programs to the Stage, too?

3
. change brigh FF
We can add this program to

make our city glow! -—d

£

change brightness effect by G

)




STAGE

Now let's take a look at the
Instructions sprite. It tells the
player how the game works. We'll
write two programs to control it.

9 when I receive space
broadcast start

Program @ makes the sprite show up
at the start of the game and disappear
when the player presses space, the
spacebar on their keyboard.

Program @ makes the Instructions
sprite broadcast start when it receives
the space broadcast from program (1]
This will start the game!
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Scripts Costumes Sounds

New costume:

d/ad

|. Meo-cat?

T
o
— -

<

Neo-cat1
Bc111

Neo-cat2
150117

vy -0 1 -

Next, let's write some programs

for Scratchy. Notice that he has two
costumes already: one where he's
just standing and another where he's
jumping.

So let’'s add some programs to control
how Scratchy looks. In program @, we
him before the start broadcast is
received. In program @), we control how
Scratchy switches costumes. Whenever
the player’s mouse is clicked—that is,

whenever [N —Scratchy looks
like he's jumping.

A

C C( ) )




e when I receive start
g0 to x: @D v: E&D

point in direction (CIh9

point towards mouse-pointer

3
gﬁdemserstnx: mouse X y: mouse y

when I receive Oh

say [elNTsIN} for k) secs

Tip: By using the mouse instead of the
keyboard, the player has a lot of control
over Scratchy, who will move very quickly
for this game. But remember—every
game is different! Sometimes the
keyboard works well, too.

Time to program a new sprite! Switch to
the Server. It should look like the image
below, but we want it centered and at
the bottom of the screen. Add this simple
program so that the Server appears in
the correct place.

But how does the player control
Scratchy? Program € lets you
control Scratchy with the mouse,
showing him only when the start
broadcast is received.

Program @ makes a speech
bubble saying “OH NO!!" appear
whenever the Scratchy sprite
receives the 0Oh signal. We'll
broadcast Oh whenever a virus
manages to hit the server.

when I receive start

=0
go to x: O v: €D e

~




Next, we'll program our computer opponent!
The sprite called Virus has a set of costumes
of letters spelling V-1-R-U-S.

Program @ hides the Virus until the game
starts. Program @ makes the Virus switch
costumes as it flies around.

when I receive start

switch costume to

Program @ for the Virus makes it (3)
fly around. It bounces whenever it

bumps into Scratchy or the edges

of the screen.

when I receive start
go to x: O y: €D

point towards Neo-cat

touwching MNeo-cat
point in direction | pick ranllnnlmto




Now we'll add more programs to the Virus to
keep score. These programs use blocks from
the Control, Events, and Data palettes to
record and signal the conditions for winning
and losing.

Program @ creates a new variable called
score and the conditions we need to meet
for the script to broadcast win. Your score
will now appear on the Stage.

Program @ creates a variable called chance,
which keeps track of how many times the
Virus is allowed to touch the Server sprite
before the player loses. We'll give Scratchy

five chances to start. When you're out of ——
touching Server

chances, the program broadcasts lose. Just
like the player’s score, the number of tries by &9
the player has left is displayed on the Stage
as chance.

Tip: When setting the rules for winning and losing
in your games, use the greater-than symbol (5)
or the less-than symbol (<) instead of the equal
sign (=), as we do in programs @ and ©. This will
prevent the game from breaking when a variable
changes too quickly!

Why might the variable change too fast in this
game? Scratchy might touch the Virus a few times
in quick succession, and the program won't realize
that you've won the game.




Now let's look at the sprite for the winning screen.
Programs @ and @ keep it hidden. Then program
© makes it appear when the win broadcast is
received from the Virus sprite.

The losing screen is pretty similar to the winning

screen. To save time, we can select the Duplicate All we need to do now is

tool and click the winning screen to copy both the change the costume and

image and the programming! the last program a bit.
(- )

when I receive space

hide




We're finished! After you save the file, hurry
and help Scratchy the hacker defend the
network from the virus attack!

How would you make this game harder for the
player? How about adding different kinds of
viruses? What about turning this game into a
two-player Ping-Pong match? Give it a try!
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ACCORDING TO THE THAT'S THE FAMOUS RIO DE
SECRET MANUAL, IPANEMA BEACH IN JANEIRO

THE VIRUS CAME RIO DE JANEIRO,
FROM IPANEMA! BRAZIL!

HAVE TO
WEAR A =
SWIMSUIT? 4

“I‘\‘\ 1y

|
|
"y

| ‘ ‘\ ‘\ 0 A
gy
I CAN FEEL A
COSMIC DEFENDER ®
NEARBY! @

GOBO! FABU!

/_\&Q@\ I'M TRAPPED IN
WOW...BUT _\@\%_THIG GOALPOST!
EVERYONE'S HANG IN

FROZEN! THERE, PELE...
WHAT ARE WE

) 7S w GOING TO DO?

I CAN HEAR A
SQUEAKING NOISE
FROM FAR AWAY!

IF You
WANT TO BEAT A
GOALPOST, THEN
YOU'LL HAVE TO

USE A SOCCER

LET ME TAKE
ON THE
CHALLENGE
THIS TIME!




RIO SHOOT-OUT

el 1

Learn how to program a Shoot penalty kicks and
soccer game with a targeting avoid the moving goalie.
system, several related rules, You'll win the game if you
interactive sound effects, and manage to score five out of
a vivid, animated backdrop! eight tries!

Bull's-eye '
Here's a look at the final game.

1’ ‘ We'll need to create a targeting
w " - system that will move over
Rio de Jane"’o % _ the goal. When you press the
N S ) spacebar, you'll kick the ball
where the bull's-eye is. But
watch out—the goalkeeper
will dive every time you kick
the ball!

To start, you can upload the file
05 - Rio Shootout.sh2 (File »
Upload from your computer),
which has all our sprites but

no programming blocks yet.

You can draw your very own
backdrop if you like!

Scripts Backdrops Sounds

b

New backdrop:
“/am




STAGE

Nﬁ

FER -0l

-

@

| created a sprite

for the clouds. Click
the Cloud sprite, and
then add a program
to make it float up
and down. This will
make the backdrop
livelier!

If there's a beach, there must be
some waves! The Wave sprite is

| Clear |

Scripts | Costumes | Sounds |

Hew costume:

d/aE

separate from the background,

and we'll give it some programs of

its own.

&+

Cloud

—y

» 1




Since waves move up and down
as well, their programming will
be similar to the script for the
clouds. Here’s a little trick: First,
select your Cloud sprite from the
Sprite List, and drag its program
to the picture icon of the Wave
sprite in the Sprite List. Make
sure your cursor is right over the
Wave in the Sprite List, and then
release your mouse. Now you've
copied the programming for the
Cloud sprite to the Wave sprite!

We can also change the Wave's
script to make it move faster and
more frequently than our clouds.

=i Pio du Fanairo g

Rio de Janeiro ¢

‘_ our Goalpost sprite
and write a program to
[Goalpost set its position in the

wait msers
change y by o
= p

when dlicked
go to x: 0 ¥: 0
forever
repeat €
wait m secs |
' change y by m
| -+
repeat 9 e
J waik m Sers

change y by @

Then we can switch to

center of the field.

when dlicked

go to x: Gy: m



The goal's Net has its own sprite.
Click it in the Sprite List, and then
create this short program to set its

when dicked
go to x: G ¥ m

_S_c;npts_.\ll Costumes l_Soumfs_‘

New costume:

/Al

Now is a good time to test your program to
make sure everything appears where you
want it to. Try clicking /. If your clouds
float, the waves lap against the beach, and
your goal and net are in the right place, let's
move on to programming the game itself.

Next we'll program the
Bullseye sprite, which

—

=

JUIg

1

shows where Mitch will Scripts Liciisivcaal b |
kick the ball. ———— | [__ I_

New costu
s [Bullseye

i d/adm
IO




set size to @ L

go to x: ETD v: @ |

Program @ will make
glide € secs to x: I y: €D the bull's-eye zigzag
' glide € secs to x: €T y: €D across the goal.
.glideo secs to x: E0D v: €0
.gl'lde € secs o < E1D v: €D
' glide € secs to x: €D v: €O
' glide @) secs to x: €D v: €

For program @, add these two commands
from the Data palette in a loop. We'll
use these variables to determine where the
ball goes after Mitch kicks it. You'll need to
create X and Y in the Data palette.

forever

set X to x position
[

set ¥ to y position Tip: Since our player doesn't need this infor-
mation, we can hide the variables from being
displayed on the screen by deselecting them in
the Data palette.

dear graphic effects Then add in programs © and @
forever to the Bullseye sprite. Program ©
change color  effect by €D makes the bull's-eye continuously
= change color. Program @ makes
the bull's-eye disappear when it
(4] when I receive Shoot receives the shoot broadcast.
Now when Mitch kicks the ball,
the bull's-eye will disappear.




STAGE

To make this game even more fun,

we gave Pele the Keeper two costumes.
That means we can program a simple
animation by switching costumes.

: Newcostume: |
b/ At
.,
e
-
iy
) L
e &

We'll write two programs for Pele. Program @ sets
his size, costume, and starting position and then
animates him using the command in

a loop.

When he receives the Shoot broadcast in program @,
he'll “dive” to a random spot in the goal to try to stop
the ball! The blocks are in the Operators
palette—just drag two right into the block.

when dlicked

set size to m Gl

switch costume to Keeperl

go to x:@y:@

-ﬂtmsers
¥

next costume

e when I receive Shoot

glide @ secs to x: | pick random @ to @ y: pick random @ to m

go to x:ov:@




Now we'll move on to program the
game’s most important feature—
the ball.

Scripts | Costumes | Sounds ‘

New costume:

/Al

New sound:

i & Q&

First, click the Ball in the 0
Sprite List. Check out all the 3 "
different sound effects I've |‘ e
added in the Sounds tab. GD:

You can also use your own 00:01.5

custom sounds! 4

rd

iz
Boo

00:00.5

Next, write program @ to setits starting
position and size, and then play the Whistle
sound.

Tip: The first two blocks (FEIETMEEgeL and
TR RETET) adjust the layer value

so the Ball will appear in front of the Net,
Stage, and other sprites in the game.

when

go to front
go back ) layers

set size to @ o
go to x: @ v: €D

play sound Whistle wntil done




By creating variables for Ball and
Score, you can keep track of how
many times the player has kicked
the ball and how many times he has
scored a point. Program @ sets the
starting values for these variables.

Program @ will broadcast Shoot
whenever the spacebar is pressed.
Notice how there’s an f§j loop that
uses a block from the Operators
palette to make sure the player isn't
out of balls (Ball > 0) and hasn't won
the game (Score = 5).

Program @ is a neat animation trick.
It makes the ball shrink into the dis-
tance by using a negative value (-2) in

the block.

when space ey pressed

not

if Ball >m and Score :E then

broadcast Shoot and wait

when I receive Shoot

change size by e

Program @ is quite special. First, it makes the ball
our variables X and Y. (Just drag them from
the Data palette right into the block.) The two
loops contain the game’s program for scoring.

It broadcasts either Goal or Miss, depending on
whether or not the ball touches Pele.

when I receive Shoot

by &9

glide @ secs to x:

change Ball

X y:| Y
if touching Net ?  and

broadcast Goal and wait

if touching Net ? and

and wait

broadcast Miss

not touching Keeper

touching Keeper



You'll score a goal if you

manage to sneak the ball
by our goalkeeper Pele!



STAGE

when I receive Goal
change Score by o

say for €9 secs

set size to @ %%

go to x:@y:@

when I receive Miss

change Score by 0

say m for o secs

set size to @ O/

go to x:@v:@

Programs @, ©, and o
@ play sound effects
for fun.

Now let’'s add some more programs to
the Ball. In programs @ and @, we'll
determine what happens after a Goal or
Miss. Program @ will the Score
by 1, while program @ will it by
0. Whether the player scores or not, the
ball returns to its original position after
1 second.

N,

when I receive Shoot

play sound Kickeff wntil done

when I receive Goal

play sound Goal until done

when I receive Goal
wait osers
if Score :E then

breadcast Won and wait

when I receive Goal

Ball =m and not

broadcast Lost and wait

when I receive Miss

Bal:mﬂlen

broadcast Lost and wait

when I receive Miss

play sound Boo until done

Next, we set the rules for
winning and losing the
game. Program @ will
broadcast Won when the

Score variable reaches 5.
Programs @ and @® will
broadcast Lose after all
the player’s chances are
up; that is, when Ball =
0. (Without program @®,
the player can still lose
even if he scores with his
last ball.)




Scripts | Costumes | Sounds |

S/am

b

You Won!!

Won
27875

2

You Lostll

Lost
280x75

go to front

switch costume to Start

when I receive Won
go to x: 0 ¥ @

switch costume to Won

when I receive Lost

go to x:@v:@

switch costume to Lost

Finally, it's time to program our Banner

sprite. It has three costumes for the game

instructions (Start), the winning screen
(Won), and the losing screen (Lost).

Ml Score 5 to win!!|

You Won!!

You Lost!!

Then we add these three programs to
show the costumes at the right time.
Script @ shows the Start costume

so the player has instructions at the
start of the game. The Won broadcast
will make costume Won appear in
script @, and the same happens for
the Lost costume and Lost broadcast in
script ©. The block at the end
of scripts @ and @ will stop the game.




Don't forget to save your game before you take
on the challenge to show off your soccer skills!
Remember: Press the spacebar to kick the ball.

Scratchy’s Challenge!!

Can you transform this into a shooting gallery game
at an amusement park? How about making Pele a
better goalkeeper? Give it a try!




STAGE




PELE'S BACK!

ALL THE COSMIC

. DEFENDERS ARE

THE LOCK IS BACK TOGETHER

BROKEN! WHAT
AWESOME DON'T SELL
SOCCER SKILLS! ) o YOURSELF
SHORT, MITCH!

I ONLY WON
BECAUSE OF
EVERYONE'S
HELP AND THE
LET'S WORK
DIRECTIONS FROM TOGETHER TO

THE SECRET
RESTORE THE
MANUAL! 9 BALANCE OF THE
UNIVERSE!

THERE'S A
MAGIC GEM IN THE OH NO! WE CAN'T
GREAT PYRAMID OF OPEN A STARGATE NEAR THE SAHARA DESERT
GIZA. WE NEED TO GET THE PYRAMID BECAUSE
IT BEFORE THE DARK OF THE MAGIC GEM'S

WIZARD DOES! INFLUENCE!
Q ) THE TRUCK'S

READY TO

44 GO. HOP ON,
EVERYBODY!

16Uess
WE'LL HAVE TO
GET THERE THE
OLD-FASHIONED
WAY!

NO!! THEY TOOK

HURRY UP AND
START THE CAR!
WE HAVE TO
CATCH THEM!
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DESERT RALLY RACE

Crmeres, Fre—— S TAGE

Learn how to create a Control Scratchy’s car to avoid obstacles
scrolling game, program and to run away from the Dark Minions
complex movements for in order to reach the Great Pyramid of
the sprites, and make a Giza. Each time you crash your car, one
backdrop change over time. of the Cosmic Defenders will jump out.

If you crash your car four times, your
car will break down!

Let's start by uploading a project called 06 - Desert Rally.sh2
(File » Upload from your computer), which already has a bunch
of sprites in it. It doesn’t have any programs yet, but we’'ll add
some soon.

First, let's look at the Stage. If you click the Stage in the Sprite List,
you can see that we have a lot of different backdrops.

—




STAGE




add

Backdrops for the Stage are just like costumes for any
other kind of sprite. So let’s write a program that controls
how they change.

Program @ will make the backdrop change over time in
two loops, day and night. You can use the Duplicate tool to
save time with the programming! This animation will give
the Stage a cool look as Scratchy drives.

Program @ will make the Stage change its backdrop to the
Win costume when the finish broadcast is received.

4

Day_4

switch backdrop
T -a't.m Sers
I switch backdrop
..-ait m Sers
i switch backdrop

[
-a'tmsers
¥

| K

Night_1

| K

switch backdrop

Night_2

| K

switch backdrop Might_1

Night 3 wait () secs
8 switch backdrop
- e
1 switch backdrop Night_3
Nt 4 et @ secs
g switch backdrop Might_4
i
i switch backdrop Night_5
that & it @) secs

&

switch backdrop Night_&
" —

Night_&
480nc350
11
- e when I receive finish
“ou Win!t switch backdrop to Win
Win

480360




STAGE

We'll also have the Stage keep track
of the time in program ©. So create
a variable called Time from the Data
palette. We and then ;
change it by 1 with each second. We'll ot O secs

use the Time variable again later. changa Time by €

) &

Next, let's look at the road. Try
to use the whole width of the
Stage if you're drawing it!

-




ad

Adding these programs to
the Road1 sprite will make
it appear on the screen and

scroll to the left.

when dicked

to m

set Scroll

forever

change Scroll

by &9

go back o layers

when
forever
if Scroll < FE¥E]

set Scroll  to ﬂ

then

Write program @ to make the Scroll
variable continuously decrease by 1

(GEI@MCchange Scroll by -1)}

Program @ will set the road’s position. Set
the y coordinate to 10 so it won't move up
or down, and then add in
a loop. By doing this, the road will
continuously move to the left as the Scroll
variable changes.

Program € will make the Scroll
variable reset to a O value once it
reaches a value less than -479.

Tip: Why did we use the number -479?
The width of the entire Scratch Stage is
480 pixels, so that's when it will roll off
the Stage.




STAGE

Add this program to use the Scroll variable
from the first road sprite. This time, we use a
trick to make Road? follow right behind Road1.
By setting the x coordinate to Scroll + 480, we
know Road?2 will always follow behind Road1.
This means that the player always has a road
to drive on, no matter what!

Next, switch to Scratchy’s Car sprite. J

Now duplicate the Road1l sprite
to create a second sprite called
Road?2.

when

go to front

Scripts Costumes Sounds

New costume:

o/ ad

[Car

Car
121111




Program @ for the Car does a lot of work. First, it
sets the costume, size, and position.

The loop holds the rest of the program. The
block will pull the car down, giving it
gravity. The block makes the car

bounce up whenever it touches the black part of the
road, making it seem like they're driving on a very

bumpy road. The block

will broadcast jump and then wait.

switch costume to Car
set size to @ oo

go to front

go to x: EED y: €D

change y by a

"

if touching color ? and ¥y position = then
change y by m
13
| wait @ SeCs

-
if key up arrow pressed?  then

| broadcast jump and wait

change y by m

repeat until touching color ?  and ¥ position <

change y by 9

Program @ makes the car “listen” for the jump
broadcast and makes the car jump up.

The block in program @

will temporarily stop the first program so the second

program can run.

,_
)




STAGE

Now add program € so
that the car can move left
and right.

when

forever

if key right arrow pressed? then

move 9 steps

-
if key left arrow pressed? then

move E sheps

In program @, we add some speech bubbles
as instructions for the player.

In program @, we create a new variable called
Life. When the Life value is less than 1, we'll
set the car’s costume to Boom! and then end
the game with the command.

=10 Press Loor R keys to move, UP key to jump! RLT o secs

=0 Avoid the obstacles! R40 0 secs

when
set Life to ]

-iitoseﬁ

\

\
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Once you're finished with the Car sprite’s programming,
you can add some passengers—the Cosmic Defenders!

You can use the three sprites that are already in the project,
or draw your own. | put Gobo at the back, Fabu in the middle,
and Pele in the front. It's okay if your sprites overlap a bit—
these guys are just coming along for the ride.

o

Scripts Costumes Sounds

~
New cost:me: [Gubu
d/am
,
- ® \
Gobo ||
L 104120
i)
~ Scripts Costumes Sounds
New cost:me: [Fabu
d/aB
2
\
Fabu |
& 112126
Y
- Scripts Costumes Sounds
Newcost:me: [F'ele
d/aB
.
g \
Pele ||
L 116144
)




STAGE

Write this program for Gobo. It sets his size
and position and uses the block so he'll
always follow the Car sprite. Once the variable
Life drops to less than 4 (EX7HEE). he'll shoot
to a random area. When he touches the top of
the screen (RSl EEL), we make him
disappear by using the block.

when dicked

set size to @ %o
go to front

go back o layers

point in direction @

repeat until  Life ‘-‘..

change y by m
b

point in direction = pick random m to m
glide o secs to x: | pick random mto@ ¥:

if ¥ position :lhen




go to front

go back o layers

point in direction m

Do the same thing for Pele,
but change the Life value to 2.
Because Pele’s sprite is a little
bigger than the others, we also
set his size to 25%.

q

Drag and copy Gobo's program onto
Fabu in the Sprite List. You'll need

to change only a few things. Most
important, change the
block to [EETIEE], so Fabu will bounce
out at a different time.

when diicked

set size to ) %

go back o layers

point in direction m

change y by m

(5 ~
-ﬂ@seﬁ
¥




Now we can add the programming for the
obstacles. First, let’s take a look at the
STAGE thorny and dangerous Bush sprite! It has

two costumes.
4

Scripts Costumes Sounds

New costume: [Bu5h1

d/aE

W
Bushi ||
114108

: ®

wr
O

And then write these three
programs:

Program @ controls when

the bush appears and makes
sure it moves with the road.
Once it touches the left edge
of the screen, it'll disappear o
and switch to the next bush repeat unti

costume. e

Program @ programs the Car
to (that
is, lose one life) whenever it
touches an obstacle. Notice
how we programmed the
/ computer to check if the
player still has enough
Life value left using the
’ ¥ and [ blocks.
‘ And program € makes
the bush disappear once it

receives the finish signal,
which ends the game.

9 when I receive finish
hide

XA\ /4 o
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, . Scripts Costumes Sounds :
Now let’s look at the Tower sprite,

which also has two costumes. This New costume:
obstacle will be tough to jump! ? / a G

|- Tower1

i

Towerl

Tower2
TTxE8

v -0 1 -

We can once again copy
the program we created
for the bushes. Edit the
costume name and the
time it appears, and
you're good to go!

when I receive finish
hide



STAGE

Take a look at the sprite for
Legs, the evil octopus Dark
Minion. But don't you think
it's a little boring just to
have one image for him?

Why don't we try
animating him?

In the Paint Editor, use
the Select tool to grab
the end of his tentacle.

i

2

Next, click this button to
flip his arm up and then
drag it back into place.

|\ W

\0 \V




ad

Do the same for his other tentacles,
Scripts Costumes Sounds

and there you go—a new look!

p New costume: [LEQS1
e

= IR

ez e

; @

£

. et &

Tip: Editing existing costumes is an easy
way to animate a character without having
to redraw it. The Select and Rotate tools
let you quickly change the position of a
sprite’s arms and legs.

Vector-based art is even easier to squish
and squeeze into new shapes—this makes
it great for animating characters.

>

Now let’s get back to pro-
gramming! Program @ makes
Legs switch between his two
costumes in a loop.
Program @ makes him
when he receives the finish
broadcast.

> 9 when I receive finish




STAGE

Programs & and @ control when dicked
Legs's movements and make e
him an unpredictable obstacle
for Scratchy’s car.

wait pick random m to m secs

:gn to x:@y:m

repeat untill  x position é

change x by 9

change y by 9

Lastly, program @ for Legs
adds a condition that will
subtract life points from the
Life variable, just as with the
Bush and Tower obstacles. #  touching Cor 7 and mot Life =[] then

change Life by a
s

l-a't'ﬂsers

forever




And now we'll move on to

the final sprite of the game:
Egypt's Great Pyramid of Giza!
Let's start with this photo:

Write a script so that the pyramid slowly
appears from the right, after the game is run
for 60 seconds. Once it reaches the center of

the screen (JIFTYELSLI e ). it broadcasts the

finish signal. When the other sprites receive

this signal, the game ends.

By using this sprite, we'll make
it look like Scratchy is “arriving”
at the pyramids. | edited the
Giza costume so that the cool
backdrops will show through
and so that the bottom matches
the orange of the road. Now we
can make the photo fit into our
existing game.

=7
>

\

Scripts Costumes Sounds

switch costume to Giza

go to x: E) v: ED

repeat until x position :m

change x by 9

broadcast finish and wait




STAGE

After saving your file, board Scratchy’s speedy
car and drive into the Sahara Desert to begin
your wild adventure!

Can you use these programs to create another scrolling
game? Give it try! (Tip: The height of Scratch’s screen
is 360 pixels.) Make the game even more challenging
by having the car go really fast!




STAGE




STAGE

x, $ 4
TSIZAI/\‘/E};FO\S:ZE DON'T GIVE UP!
BEST, BUT THEY WHAT WILL WE DO THERE HAS TO
STILL GOT WITHOUT MITCH'S BE A WAY!
AWAY! PROGRAMMING?

THERE'S THE
GREAT PYRAMID
OF GIZA!

WELL THEN, 1
écvlgiTilA-lr:’ LEOA\SI‘%'O GUESS WE SHOULD
USE THE SECRET GIVE YOU THE
MANUAL! OH! AND IF WE FIND
THE MAGIC GEM,
MAYBE WE CAN GET
MITCH BACK!

VAUA .

THERE ARE A
THANKS, GUYS! LOT OF TRAPS IN *S/GH*
I KNOW HOW TO Ly, THERE. YOU MUST JEE AND I THOUGHT
USE IT NOW! BE CAREFUL! , | EGYPTIANS LIKED
- 3 CATS.

NO MATTER WHAT,
DON'T GIVE UP!
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ESCAPE THE MAZE!

STAGE

Learn how to design an Guide Scratchy through the maze,
interactive maze with a and into the treasure room to
guard, booby traps, and collect the Magic Gem. After he
treasure! picks up the Magic Gem, other

° traps in the pyramid are sprung,

and he must escape!

For this game, begin by uploading a project
file called 07 - The Maze.sb2 (File » Upload
from your computer). This project file has all

x. the images you need for the game, but none
of the sprites have any programs yet.

. Take a look around, and especially take notice
. of the Stage. You can see that all of the walls
in our maze have the same orange color. We'll
* use that color as the boundary, so Scratchy

can't walk through walls!

»*
Tos
e
o
Scripts Backdrops Sounds
. New backdrop:

|.F'3-ramicl

A




STAGE

Scripts Costumes Sounds

New costume:

d/anm

|'Int|'_-,--Cat

Click the sprite for Scratchy called Indy-Cat New sound:
in the Sprite List. Then click the Sounds . +
tab and add a sound effect for him. Either I'\ % -l

record a “meow” yourself or use the Cat 1

sound effect. We'll write a program to ”

make Scratchy meow whenever he bumps l‘ :

into a bad guy or trap. Cat
00:01.0

Let’s begin by thinking about
how the game should start
and how the player will win
at the end of the game.

 say PRI for € secs
[ 2

broadcast won

and wait

Program @ gives the player the instructions for
the game using the BB block. Now when the game
starts, the player will know he needs to grab the
Magic Gem to win.

And, of course, to end the game, Scratchy needs to
escape the maze with the Magic Gem. Now let's write
a program for the end of the game. Program @
uses a special kind of block within a loop.
If Scratchy touches the color blue—that is, the blue
sky of the exit door—he’'ll say “Yeah!!” and broadcast
Won, which will cause the game to end. (Because the
maze itself doesn't have any blue, we don't have to
worry about ending the game accidentally.)

To write program @, drag the com-
mand from the Sensing palette into the f&j block.
Click the color inside the block, and an eyedropper
appears. Click the blue of the doorway, and you're
all set. We'll use the command for
another neat programming trick next.



Now take a look at program ©.
It looks pretty complicated, but
it's really not so hard. Can you tell
what it does just by reading it?

First, we set the direction and position of Scratchy.
That’s simple enough. But what about the big
loop? That holds all of the rest of the program, and
that's how we'll program Scratchy’s movements.
First, if you press the up key, you can see there’s a
command that will EEREREEEE. But then inside
that ij loop, there’s a second & loop!

If Scratchy is touching orange, the computer tells
Scratchy to METTAEIEE] What's that all about?
Well, did you notice that the walls of the maze are all
orange? So if Scratchy bumps into the orange wall,
we want the wall to stop him. And what does 3 + (-3)
equal? That's right, 0. So when Scratchy touches the
orange wall, he doesn’t change his y position at all.
He won't move! Cool.

The down, left, and right i§j loops work in just the
same way, and they have a second [ loop inside
them as well. Make sure to pick orange with the

eyedropper for every fEgadellldsiilefieonfess command.

Now Scratchy can't walk through the maze's walls or
gates. Notice that the edge of the Stage has a thin
band of orange, too. Scratchy can't walk off the Stage
either! He's trapped in our maze, just like we want.

Finally, for program @, we use the block and the [
block to program what will happen whenever Scratchy bumps
into a trap or a bad guy. A speech bubble will say “Oh!", the sound
effect Cat will play, and Scratchy returns to his starting position.

Tip: The second BB block is blank. This makes the “Oh!” disappear. J

: J

: touching Tumstile ? or touching Whiptail ? or touching Wall_L

? or touching Wall R ? or touching Stone 2




STAGE

Now is a good time to make sure that your programs work as you
expected. Click /™, and make sure Scratchy moves up, down, left,

and right. Try bumping into the walls of the maze. Does Scratchy
stop moving once he hits a wall in all four directions? If not, go
back and double-check your programming. (Remember that if
Scratchy touches the orange wall, his movement should add up
to 0.) Try hitting an obstacle or a bad guy to make sure Scratchy

returns to the start of the maze.

Scripts Costumes Sounds

Hew costume: f

[ Whiptail
d/anm
1

<%,

Vhiptail
180128

V1N

Then click the Turnstile sprite,
and write a program to make it
spin using the block. The
sprite doesn’t move around at all,

so we just need to set one position.

Next, click the sprite for Whiptail, the
Dark Minion guarding the pyramid. Write
a program that sets his size and starting
position and then makes him pace back
and forth in the maze.

when dicked

set size to ) %

gﬁdeﬂm to x:@v:
—

\_ J

Scripts Costumes Sounds

New costume:

o/aB

|.Turnsti|e
N\

Turnstile ||

2181




At this point, take a look at the Lock and Key sprites,
which are circled in blue below. Scratchy will need to
pick up the Key first, in order to open the Lock. Let’s

create some programs for them next.

First, click the Lock in the
Scripts Costumes Sounds Sprite List to give it a simple
program—this just sets its

New costume:

|'|_g.;:/._ location in the maze. The
é / ﬁ (O] program that actually opens
: the gate is in the Key sprite.
Lock | ]
1830




STAGE

Scripts Costumes Sounds

New costume: |

d/aB

L ) Tip: When creating the Key sprite, | used

the Set Costume Center button in the
Paint Editor to make sure Scratchy and
the Key don't overlap.

Click the Key in the Sprite List, and listen to its sound
in the Sounds tab. Then click the Scripts tab to write
this program. We want a sound to play when Scratchy
picks up the Key and then have the Key follow Scratchy,
using the command. When the Key touches the
Lock, the Gate Open signal is broadcast.

New sound:

i A
(& o g0 to x: €D v: O
1

l‘ Fe | | touching Indy-Cat 2

h play sound AfroString
AfroString ;
00:00.8

go to Indy-Cat

[ play sound AfroString
3
broadcast Gate Open




—v)

: =

-
Now to program the Gate sprite.
N N I e Because it has an orange border
just like our maze, Scratchy can't
ﬂ ﬁ d E? E enter the treasure room unless it
..
= moves!
HEE | Sl
- ~ Click the Gate in the Sprite List, and
. then test out the DirtyWhir sound
Scripts Costumes  Sounds to the Gate in its Sounds tab.
New costume: =
* |l:ate
'@ /- New sound:
F < & &
\ 1
ra
i< ~
- DrirtyWhir
00:00.8
-
Now for some programs. Program @ just sets
the Gate’s location. Program @ makes the
Gate glide out of the way when the Gate Open
broadcast signal is received. Program @ plays
a sound effect. (2] when I receive Gate Open
think for ¥ secs
glide ) secs to x: @) v: O
If you haven't tried out the game yet, give it (3] when I receive Gate Open
a test now by clicking /™! See if you can get L
Scratchy to enter the treasure room.
——— 0 e - @ i
r  FEa I IS ele I
EreAY Ay - Sz

%




STAGE

New sound:

<&@

1
Fa
1z

Fairydust
00:00.5

If it's not already there, you
can just drag the sprite on

top of its stand on the Stage.

when dicked

go to x: &9 v: €D

’ touwching Indy-Cat
play sound Fairydust

think for @ secs

7

Scripts

New costume:

d/aB

Wagic Gem
1528

Costumes Sounds

|'f'v'lagic Gem

1N

Next, let's program the Magic Gem
sprite. We'll use a sound effect
called Fairydust in the Sounds tab.

Ke

Then write two programs for it.
Program @ makes the Magic
Gem change colors. Program @
sets the Magic Gem’s position and
then uses a block to
determine what happens when
Scratchy grabs the Magic Gem.
When Scratchy touches the Magic
Gem, it broadcasts Stone. This will
release the final traps in the maze!
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Eliﬂi When Stone is broadcast, we

. i .
want to activate the rolling
stone and the spiked wall traps.

Scripts Costumes Sounds Our spiked wall trap will

) actually be two different
[Wall L sprites. Wall_L (the left side

New costume:

'@' / ﬁ [ O] . of the trap) gets one simple
1 program to set its position.
Wall_L [ |
12380
-_




STAGE

The right side has its own sprite called Wall_R. Create
these two programs to set the position and make it move.
This wall listens for the Stone broadcast and begins to
back and forth, most dangerously!

Scripts Costumes Sounds
when dicked

go to x:\r: 67

Hew costume: (
[Wall_R

ﬁlleasers to x:@v:@
»
ﬁcleﬂsers to x: {3 v:

53 -

d/aB

1 = - rec Stone
Ny
-

Waiting outside the passage is a
rolling boulder sprite called Stone.
I've used different shades of gray

for the Stone to give it a 3D look. y
Scripts Costumes Sounds

New costume:
d/an

1

|.Stnne

Stone

VN

Program @ for the Stone will make the
sprite appear to roll, giving it a realistic
animation. Program @ controls the
movement of the Stone—it rolls down
the passage and then appears again

at the start, in a loop.

3
gﬁdeesers to x:mv:@
»

hide




Finally, we have a sprite for the
winning screen called Won.

Scripts Costumes Sounds

Hew costume:

d/aB

[Yuu Won

You Wan!!

You Won!!

Y'ou Won
A80ec350

New sound:

LR =~

Won
00:05.9

Write these three short programs. Program @
hides the sprite, and program @ displays it only
when it receives Won. Program @ plays the sound
effect we added in the Sounds tab.

9 when I receive Won

Tip: The command in program & will
make the Stone, Whiptail, and all other sprites
stop moving.

when =
R e Wondering where that Won broadcast will come

from? Remember that Scratchy broadcasts Won
when he touches the blue in the doorway. We
added that way back in program @ on page 108.
So we're finished! Yes!

play sound Won until done
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Save your project so you don't lose any of your
work! Now help Scratchy collect the Magic Gem
and escape from the dangerous maze.

Scratchy’s Challenge!!

By making the sprites smaller, you can create an

even more complicated maze with more traps. Or
you could add a second player and make it a race
to the finish! Give it a try!







1 GOT THE
MAGIC GEM!

IT'S WHIPTAIL
AGAIN! RUN!

WHEW. WOW, WHERE

1G0T 1T, @
J

NEVER MIND
ABOUT THAT. USE THIS
MAGIC BROOM TO RACE
TO THE SECOND GEM
BEFORE THE DARK
WIZARD GETS IT!

THIS BROOM |5
AN OLD MOPDEL,
50 YOU'LL NEED
TO WAVE YOUR
WAND TO MAKE
IT GO FAST!

WHO
DESIGNED THIS
CRAZY MAZE?!

THE MAGIC
GEM BROUGHT
US TO THE LAND

. OF MAGIC.

RATA? WHY
ARE YOU
) HELPING US?

MEOW! THANKS
FOR THE TIP.




SORCEROR'S
CHALLENGE

_ — Chapter Focus

STAGE

Learn how to control This is a simple “button-mashing”
the Stage with multiple game. Rapidly press two keys
costumes, play music with back and forth to make Scratchy
Scratch, and create other fly. He needs to beat all three
animations. levels within 15 seconds to collect

the second Magic Gem.

Open the Scratch project 08 - Wizard’s Race.sb2
(File » Upload from your computer). This project file Scripts Backdrops
has all the sprites you'll need, but it doesn’t have

any programs yet. We can customize how it looks Mewe by falng:

later. For now, we'll focus on the programming. e / ﬁ (o]

First, let’s take a look at the Stage. It has three
backdrops. We'll use these as levels for Scratchy’s
ride on the broomstick.

Q-0 1 -

=

I




STAGE

Write program @ for the Stage to set

its first backdrop. Program @ changes
the Stage's backdrop when it receives the
next level broadcast.

Tip: You'll need to choose new message...

in the dropdown menu of the
block to create the next level
broadcast.

Create a LEVEL variable, and then write
programs € and @. Program € makes
sure that we start at level 1. Program @
listens for the next level broadcast from
program @ on page 124 and increases
the LEVEL variable by 1.

e when I receive

forever

e set TIME to € - timer

13

i TIME < [  then

broadcast LOSE

switch backdrop to Stageil

when I receive next level

next backdrop

when diicked

set LEVEL o]

when I receive nextlevel

change LEVEL by o

Create a second variable called TIME, and then
write program @, which gives you 15 seconds to
complete the race. Program @ broadcasts LOSE
when you've run out of time.

Tip: Program @ has a couple tricky things in it.
First, you'll need to create a new Start broadcast
in the block. The script also makes
use of Scratch’s built-in timer variable and uses

some special commands from the Operators,
Events, Sensing, and Data palettes. You need
to use the block in program @, as
Scratch’s timer starts just as soon as you open
the project. This command will let you try the
game again after you've lost, too.




Next, we'll program the sprite for
Scratchy the wizard. The sprite is
called Harry-Catter and has two
costumes. We'll give him two sound
effects, too, in the Sounds tab.

Scripts Costumes Sounds

o [HarryCatterZ

|

HarryCatter1
14Tx111

Fairydust
00:00.5

Then write program @ to
set his starting costume and
position. Program @ makes
him float up and down.

go to x: EED v: @
switch costume to HarryCatter2

go to front

change y by 9
b

wait m Sers

’

change y by Q
b

l-aitmsers



STAGE

Program © controls how Scratchy moves. The
player will need to press the left and right arrow
keys, one after another, to move Scratchy.

e when I receive Start

key leftarrow  pressed?

move @ steps

-

if key left arrow  pressed?

switch costume to HarmyCatterl
»

mowve m steps
3

wait until key right arrow

switch costume to HarryCatter2

»

mowve m steps

and key right arrow  pressed? | then

key right arrow  pressed? then

and mnot key leftarrow pressed?

Can you see how this program works? The player can start
with either the right or left arrow. The [Jflf block makes
sure the player doesn't “cheat” by pressing both the right

and left arrow keys at the same time.

o when I receive Start
l'epeate
wait until touching Magic 2

¥
play sownd Fairydust
{3

play sound Zoom
{3
broadcast next level

L

go to x: €ED v: O

*

say NESYER for (X secs
g

»
EEUN Get the Magic Gem! BG1 o secs
wait wntil touching Magic ?

broadcast WIN
-

Finally, write program @ so that once
Scratchy reaches the Magic sprite, sound
effects will play, next level is broadcast,
and Scratchy says “Next Levell” Remember
that the next level broadcast will make
the Stage change backdrops.

After that loop repeats twice, the player

is on the third level. Scratchy will now say
“Get the Magic Gem!” and broadcast WIN if
he reaches the Magic sprite in time.




Now let’s take a look at the costumes for Magic, the sprite that
is our Magic Gate and the Magic Gem. The sprite will appear on
the right of the Stage, and it will serve as Scratchy’s goal for
each of the three levels.




Scripts iCostumes |Sounds |

HNew costume:

[I‘\u"lagic Gem ]
s/am b4
| v
[\ |
L Here are those costumes for this
Magic Gate ‘ - sprite. We'll change costumes with
L — each level, with the Magic Gem as
2 ‘ o l Scratchy's goal for the third level.
—_— (That's why we have two Magic
‘ d K ! Gate costumes and one Magic Gem
T - s costume—we have three levels.)
183144 | & :
&

ST

«

when clicked | Program @ sets the sprite’s position
and its first costume and creates a
go to x: G\r: @ . .
— — animation. Program @
g changes the costume with each next
level broadcast, and program ©

change color  effect by € makes the sprite float up and down.
3

forever

when I receive next lavel

next costume

change y by 9

change y by 9




S

Scripts Costumes Sounds .
I | Now we can add some magical

New costume: e | visual effects to our game. There
& of & ;e"am— is a sprite called Terrain that has

&
these three costumes.

Next, write program @ to continuously
change the Terrain sprite’s costumes and
set its starting position. This gives a neat
animated effect to the ground. Program @
makes the Terrain change colors magically!

Terrain_3
480124

when dicked

go to x:ov:@

switch costume to Terrain_1

[ wait m Secs

'5w'rl:c|| costume to Terrain_2
| wait '@ sSecs

'sw'rtcll costume to Terrain_3
' wait @ Secs

¥

switch costume to Terrain_1

change color effect hvo



Now it’s time for the text for our
game. The Titles sprite has a bunch
of instructions for the player. We'll

use its Countdown_3, Countdown_2,
Countdown_1, and Go costumes to
create a countdown to start this race!

New costume:

d/al

Hit L & R keys to fly through 3
levels within 15 seconds!!

Yol Winl*

You Win!! You Lose!!




The Titles sprite has Write program @ to set the order of each costume.

three sounds. You can We use the and blocks to
add your own in the add fun noises to the game.
Sounds tab.

New sound:

G & &

>
1z
b
WaterDrop
00:00.3 switch costume to Ready
3
I‘ ': play sound WaterDrop until done
~ wait m Secs
gz::‘l‘ set instrument to @

switch costume to Countdov

play note @ for m beats

switch costume to Countdow

Here's that Start broadcast play note 3 for () beats
at long last. Remember that switch costume to Countdown_1
this is what the Stage and play note (39 for (X beats
Scratchy are waiting for!

switch costume to Go

play note @ for m beats

broadcast Start

set volume to @ O
b

play sound Xylol until done

when I receive WIN

switch costume to Win

Finally, write programs @ and © for the
winning and losing screens, depending on
whether the Titles sprite receives the WIN
when I receive LOSE or LOSE broadcast. And now our game is

complete!

switch costume to Lose




Hit L & R keys to fly through
3 levels within 15 seconds!!

Save your project, and get ready for a race!
Click /™ put your fingers on the keys, and
get ready to set a speed record.

Scratchy’s Challenge!!

Can you edit this game to make it a two-player
race? How about a two-person watermelon-eating
contest? Give it a try!



STAGE




HOW DARE YOU
MEOW! TRY TO FIGHT ME!

I CAUGHT GIVE ME THOSE
THE SECOND
MAGIC GEM!

MEOW, UM. 1
THINK TLL KEEP

GIVE UP THEM INSTEAD.

MUA HA HA! ALREADY! CAN'T
WELCOME TO MY YOU SEE T'VE

DARK REALM! CAUGHT YOUR
- FRIEND?

4

USE THE
MANUAL,
SCRATCHY!

"' = s
A“A\_*-’ 'kf‘a
WHY DON'T
RATA! I'M YOU PICK ON
GOING TO SOMEONE
DESTROY YOU, YOUR OWN
TRAITOR!
DARK WIZARD,
WON'T YOU sTOP?

WE STILL
HAVE TIME TO
RELEASE ITS

POWER!



THE FINAL FIGHT

meame— STAGE

Learn how to design a fighting game. Take control of Scratchy
We'll create two characters with for the final fight with
unigue fight moves, custom health the Dark Wizard. Use

. counters, and more. To make custom his saber spin, saber
animations for Scratchy’s three fight throw, and force attack
moves, we'll use a special trick to to defeat the Dark
swap between four different sprites. Wizard.

Here's a look at the final game we'll create. You'll
need to jump over the Dark Wizard’s dangerous
fireballs and launch a counterattack!

This sprite represents the
Dark Wizard’s health.

-

This sprite represents |

The computer controls o,
* the Dark Wizard.

The player controls o
Scratchy.

Let’s start by uploading a blank
project called 09 - Final Fight.sbh2
(File » Upload from your computer).
This project has all the sprites we'll
need, even the Stage. Now let’s
move on to the exciting stuff—
programming!

¥ v

o

Scripts Backdrops

New backdrop:

/& B

®.

)
2

|'Star

%i
N\
|
a




STAGE

N\

New costume:

d/an

Saber_on2
S5x104

Saber_on3
101x104

Saber_fight1
1132104

5

('_7',:"4’
i% T

Saber_fight2
101111

Make sure you click the correct cat sprite
in the Sprite List—it's the one named Cat.
This game has a few different sprites for

Scratchy! You'll see why soon.

Let’s take a look at the Cat sprite. We'll
use the first four costumes at the start
of the game to make the saber look
like it's extending! There’s also a fifth
costume we'll use for Scratchy’s jump

animation.

| also added three sound
effects to this sprite’s Sounds
tab. Don't forget that you can

record your own!

00:00.7

=
1id-
.
Hurt
00:00.2

3
”
i

Jump
00:00:2

XA - &= §{ ¥



dicked

point in direction ELM
go to x: G v: €D

dear graphic effects

switch costume to Saber onl

switch costume to Saber onZ2
switch costume to Saber on3

switch costume to Saber fightl

savfnrmsem

point towards Dark

key up arrow pressed?  then
switch costume to Saber_fight2
3
broadcast jump and wait
(3

repeat until v position = [T

change y by &)
; =

’
switch costume to Saber fighti

when I receive jump
broadcast jump sound

when I receive jump sound

play sound Jump

stop all sounds

=,
2

Write program @, which will make a cool starting animation for
the game. First, we put Scratchy where he needs to go. Then
we use blocks to change among his three
costumes. Next, we use the block to tell Scratchy to say

“Fight!” Finally, we use the block in a

loop to make Scratchy always face his enemy, the Dark Wizard.

Next, we'll write © - M
programs @, © :
and @ so that we

can move Scratchy g
to the left and right. B oV | leftamow - pre e

-a'l“sers
forever

| broadcast left and wait

*
| if key right arrow  pressed? _ then
lnrnadu:ast right and wait
Try clicking /™ to
make sure all your
programs work as

expected. The game | © Bl Sl

won't really work change x by &I
yet, but you should

be able to move (4} when 1 receive right
Scratchy back and change x by €

forth.

Programs ©, @, and @ are for Scratchy’s jump ability.
Program @ animates the jump by switching costumes,
broadcasts jump to control programs @ and @, and also
creates “gravity” in the block. When
Scratchy lands, he changes back to his original saber fight
costume. In program @, we determine how high Scratchy
can jump. Program @ is just a sound effect for the jump.

Tip: Notice how we used the block in
program @. That's to make sure the player doesn’t jump
too often or jump right off the screen! Scratchy must reach
y position -60 to jump again. That's the platform’s height.




\

STAGE

Now let's use some new broadcasts to make
Scratchy’s fight moves! We'll use a cool trick.
Whenever Scratchy uses a fight move, he'll
actually change into a new sprit. Each fight
move will get its own sprite, as you'll see.

So we'll hide the Cat sprite and broadcast
a unique signal for each move—Attacka,
Attack2, and Attack3—in program ©.

3
broadcast Attackl  and wait

key 2 pressed? . then

when I receive showl

go to SaberSpin

when I receive show2

go to Saber Throw

when I receive show3

go to Force Artack

Next, create a new variable using
the Data palette, and name it HP (for
Health Points). Write program @® to
determine Scratch’s starting HP and
how dangerous the Dark Wizard’s
attacks are. Every time Scratchy
touches the Dark sprite or Fireball
sprite, he loses 5 HP and plays the

Hurt sound, and the
block animates him.

The last program, ®, determines
what happens when all of Scratchy’s
HP is gone: A broadcast called lose
is sent.

v
broadcast AttackZ and wait

key 2 pressed? _then

Programs @, @, and @ use broadcasts
called show1, show2, and show3. We'll use these
broadcasts at the end of each attack sequence.
These will make Scratchy up again on
the screen. The and blocks are like
partners—one makes a sprite disappear, and
the other makes it reappear.

when dicked
sat HP i) 100
hide wvariable HP
play sound Saber
forever
‘il touwching Fireball ? or towching Dark ? then
[change HP by &
'plav sound Hurt
rreneaim
change color effect bvm

dear graphic effects




T Now let's set up some costumes for Scratchy's attacks. But
d/am P y :

instead of adding even more costumes to the Cat sprite,
we'll use a new sprite, called Saber Spin, for the spinning
saber attack. (Remember how we made a program to hide
the Cat sprite in program @ on the previous page?)

>

spin_2
124x111

spin_10
0x111

the Spin sound effect |‘5 ‘!, a
in the Sounds tab.
%

Then give a listen to J New sound:




STAGE

Next, use these four programs to con-
trol the saber spin attack. Program @
makes this sprite the location

of the original Cat sprite. Program @
is just a sound effect when the sprite
receives Attacki.

Program € makes the light saber swirl
around three times—by using the block
in a loop—and
then broadcasts show1 to tell the Cat
sprite that the attack move is finished.

Program @ determines how much
damage the saber does to the Dark
Wizard's Dark HP variable.

We'll use that Dark HP variable to keep
track of the Dark Wizard's health. Recall
that Scratchy already has his health
variable, called HP. Take a moment

to create Dark HP in the Data palette
now—we'll need to use this variable in
all three of Scratchy’s attacks!

Scripts Costumes Sounds

Ring
131131

go to Cat
b

point towards Dark
=

when I receive Attackl

play sound Spin until done

when I receive Attackl

broadcast showl and wait

touching Dark 7 . then

fl:hange Dark HP bvm
3

To give our program a cool look,
we can add a ring around the
saber, with the Ring sprite.

Tip: To make sure the Ring shows
up in the right place during the
game, | used the Set costume
center button in the Paint Editor
to center it at Scratchy’s hand.




go to Cat
3

point towards Dark

9 when I receive Attackl
show

e when I receive showl
hide

Scripts Castumes

\ 4 =)

New costume:

d/ad

el
{

5 1)

S

Saber Throw
111

JIPg -

| Saber Throw

Then write some simple programs for the Ring. Program @ :
makes the Ring appear in the right place, and programs @

and © make sure that the Ring appears only during the Attack1
sequence. The fisheye effect in program O makes the Ring
expand and contract in a cool animation.

We'll give all of Scratchy’s attacks some major defensive power
by skipping the health (HP) programming. (Remember that after
the end of the saber spin attack, the script broadcasts show1,
which shows the original Cat sprite, which is vulnerable to attack!
This defensive power is only temporary.)

Let's check our work.
Click /™ and make sure
that pressing 1 activates
the saber spin attack!
You can test each fight
move as you finish its
programs.

Next, let’s look at the ¢
sprite for the second
fight move—the saber
throw attack. It's a
simple sprite with just
point towards Dark one costume. We'll
: : write some programs
for it to make sure this
when I receive Attack2 sprite faces the right
B way and listens for the
broadcast Attack2 to
start (and the broad-
cast show2 to [TEE).

when I receive show2




N\

STAGE

The cool part of this attack is actually throwing the saber.
We'll give it a second sprite, called Thrown Saber, just
like we added a second sprite (the Ring) for the saber spin
attack. The Thrown Saber sprite has four costumes: a
simple saber, followed by three explosion animations.

, Scripts Costumes Sounds
We'll add a program to use these . |

explosion costumes when we hit New costume:

the Dark Wizard. /&

)

[_saberE

saber

L 4

~

of0)

10379

FEee=01 L

“

saberd
115085




\ 4 =2

You can use a sound HESERmE . (1) when T receive Atrack2 5
'
effect for the Thrown I‘; ~!¢ - play sound Saber Throw  until done

Saber and then write

program @ to make : ’ P

it play. Program @ |‘ oF

determines how much Saber Throw = 5
damage the saber 00:00.5 " touching Dark  ? _then
throw attack does. ) - ST

wait

Then write these programs. Program @ hides the

flying saber until we need it. Program @ points the

saber at the Dark Wizard and launches it! When it

hits the Dark sprite, we make the sprite switch to its L
explosion costumes. Note the special command

that finds the Dark Wizard, no matter where he is. At

the end of this program, we broadcast show2. This will

make Scratchy switch back to his original Cat sprite.

x position of Dark v: vy position of Dark

switch costume to saber2

switch costume to saber3

saberd

No matter where he goes, we can hit the
Dark Wizard with the saber throw attack—
pretty powerful! Give this attack move a
test, too, and make sure it hits the Dark
Wizard. Press 2 after clicking -




STAGE

Now let's program the final fight
move, the Force Attack. Don't
forget you can add a new sound
effect for it in the Sounds tab.

Scripts

New costume:

¢/aB

New sound:

LR -

1
”
iz

when I receive Attack3

point towards Dark

clear graphic effects

change ghost
:-a'i m SeCs

change ghost
'-a"l m SeCs
I change ghost
:-a'i m SeCs

change ghost
»

-a"lm:eﬁ

Force
00:01.5

Costumes

Sounds

[furce_attack

1N

Program @ hides this costume until we launch the
force attack. Program @ uses the ghost effect to
make the lights flash. Even though our sprite has
only one costume, we created a cool effect—this
program will make our attack pulse with energy!

Write program © to play your sound effect, and
program @ to make sure this attack will reduce

Dark HP by 100 if the Force Attack sprite touches
the Dark Wizard.

9 when I receive Attack3

play sound Force

broadcast show3

until done

and wait

.il towching Dark ? _ then

d‘lalge Dark HPF by m
-

-ﬂasers



The final program ©
will help Scratchy to
land when he uses
this attack while
jumping.

Now Scratchy has all three of his fight moves.

Click /™ and test your program to make sure it Scripts Costumes | Sounds
behaves exactly as you expected! Walk around;
press 1, 2, and 3 to activate the fight moves; New costume; [Dark
and try jumping around the screen. Now ,e. / m
Scratchy is ready for this fight. 8 —}//
v . :
Dark ||
180x158
&

Finally, we can get to
the Dark Wizard!




First, let’s set his starting position (x: 170, y: -30) and his size (65% of
the original sprite, so he’s not too big) in program @. Program @

STAGE controls how he moves on the platform. He just picks a random spot
between x:-85 and x:170 and glides there in a forever loop.

go to x: v: ED
dear graphic effects
set size to D

In program €, we use the Dark HP variable we created
earlier to keep track of the Dark Wizard's health. This
program also makes sure he always faces his enemy,
Scratchy.

In program @, we add two sets of [ blocks inside a

et DarkHp  to ERT command. If the Dark Wizard touches one of
Scratchy’s attacks, he'll [ EI T ey, (Scratchy’s attacks
already have programs that subtract from the variable
Dark HP)

point towards Cat y

show wvariable Dark HP

forever

3 towching SaberSpin ?  or touching Thrown Saber Ed or touching Force Attack o4 then
- - =
repeat m

change color effect bym

b
dear graphic effects

Dark HP <[l or Dark HP =[] then




=

Now for the Scripts Costumes Sounds New sound: g

B z 2
Dark Wizard's S : - 4 &
furious fireball [Flreball

attack! This is a /@B e J
new sprite called . |‘ g
Fireball, and you e
can add a sound D 00:00.7

effect for it, too.

Fireball
T34

1N

e

Then write program @ to control how often the Dark
Wizard uses his attack and where the fireball goes once
it's launched! Can you see how it works?

Write program @ to give it a sweet
animated look using a fisheye effect.

dear graphic effects Program @ plays our sound effect for the Fireball.

change fisheye

3
-iilmsers
b

change fisheye
.-ﬂ_‘l @ Sers
.change fisheye
| it XY socs
.i:llange fisheye

[ 4
-aitmsers

..-'-a'l pick random o to G secs

go to Dark
b

point towards Cat
b

Tip: We used move instead of glide so that
Scratchy has a chance to jump away. The

and state-
ments make the fireball disappear once it
touches Scratchy or the edge of the screen.

The I SURGEYif touching Cat

loop makes sure that the fireball actually does

damage before disappearing! )

) ) Dark HP <[f] or Dark HP =[] then
Don't forget to double-check your programming

by making sure that these fireballs do damage, [stop this scrpe

too. Click ™ and let one of the fireballs hit
>
9 when I receive Dark Attack
play sound Dark Attack until done

Scratchy! Ouch!




STAGE

Now that the main programming is finished, let’s add
custom HP counters for each character, just like you'd
see in any other fighting game. First, let's use the
yellow bar sprite for Scratchy called Health.

Scripts Costumes Sounds

New costume: [Elar
d/am
1
2
Bar [ |
243x51
\ J &

Write this program to make the health
T : bar become smaller each time HP is

? SR XD subtracted, using the block.

If Scratchy's HP goes lower than 21%,

the bar will change color as a warning

to the player. The final g&j loop hides this
sprite if HP is completely depleted.

show
-lset color effect tu@
»

set size to | HP %

i  HP <E then

set color effect to @

He <[] or HP =[] then

Scripts Costumes Sounds

Hewoost:me. [Health Box
d/an

| put a sprite on top of the Health sprite i

called Health Box. The bottom half of

the Health Box is transparent, which Cpm—

lets a triangular portion of the health

bar show through. The Health Box gets Health Box

a short program just to set its position. St

>

go to x: @D v: €D




Make a Variable
v
2l ve )

To hide the variable HP so it doesn't
appear on the screen, just uncheck the
HP variable in the Data palette. There’s

also a [gelelaErsEbike command, if you

Make a List

want to add it to your programs.

Now we can see how
much HP Scratchy has
left, just by looking

at the top-left corner
of the Stage.



For the Dark Wizard'’s
STAGE HP meter, we'll use New costume:
a costume-switching
program. The Dark Q / ﬁ &
HP sprite has seven 1 >
costumes.
>
dark1
180158
2
dark2
1800158
darkd
180158
4
darké
180158

go to x: v: €D
switch costume to darkl

set size to m O

i 2500 S ECE

switch costume to

2000 B ET

switch costume to

1500 [ =T

switch costume to

dark?
180158
lilili] = Dark HP
switch costume to darkS
EX> park HP  ond Dark HP > [l  then After taking a look at the Dark HP costumes,

add this program. It sets the size, position, and
conditions of the Dark HP variable when the
sprite changes costumes.

switch costume to darké

B> parkHP or Dark HP =[]  then

switch costume to dark?




=,
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Next, go to the Stage and find the Because we have a

custom sprite, let's use
the simplest view, the
numeric one, to display
the Dark HP variable.

Dark HP variable in the top-right
corner. You can take your pick from
one of three looks (just double-click
to change it):

e Standard view

o Adjustable view (click and drag the
ball to change a variable’s value)

e Numeric view

Now take a look at the sprites for the winning screen (Win)

and the losing screen (Lose). The winning screen gets the two
programs below and shows itself only when it receives the win
broadcast from the Dark Wizard sprite, once he's out of Dark HP.

Scripts Costumes Sounds

New costume:
d/ad

[win

go to x:@y:@

You Win!

) )

Scripts Costumes Sounds

New costume: [mse—
d/anm

go to x:'ov:@

You Lose!

when I receive lose

242058

The losing screen has two really
similar programs. Now we're finished!




After saving your work, give the game a try.
You'll definitely want to play this one full
screen. Step into Scratchy’s shoes for the
final battle.

Scratchy’s Challenge!!

Feel like playing the bad guy instead? Just program
some movement controls for the Dark Wizard, and
you'll have a two-player game. You can even add
more fight moves! Give it a try!




mmmmm




EAT MY
FIREBALL!!

IT DOESN'T
MATTER |IF IT'S THE REAL
WORLD OR THE DIGITAL

ONE. IT'S SELFISH TO
TRY TO RULE OVER
ANY UNIVERSE. REVEAL

WE'VE BEEN
TRAPPED IN THE
DIGITAL WORLD FOR
TOO LONG, SCRATCHY.

DON'T YOU LONG NOW THAT I'VE

SABER
ATTACK!!

SURPRISED? I'M
YOUR DARK SIDE,
SCRATCHY. 1 SPLIT

OUT OF YOU DURING
THE SOLAR STORM.

AND WE LEARNED TO
WORK TOGETHER, TOO!

YOU'RE ME?
BUT THEN...
WHO AM 1?7

WHY DO I FEEL
HAPPY? MY HP IS
GOING DOWN AGAIN!

WE NEVER WOULD HAVE

FOR FREEDOM? LEARNED HOW TO BEATEN YOU ALONE.

PROGRAM, I DON'T
THINK OF IT THAT WAY.
I HAVE THE FREEDOM

TO WRITE ANYTHING

I WANT!




AH, I AM AT PEACE.
THANK YOU FOR
RELEASING MY ANGER.
FORGIVE MY MISTAKES,
AND FORGIVE MY DARK
MINIONS.

WELL, LET'S
MAKE SURE TO SEE
EACH OTHER AGANN,

SCRATCHY.

MEOW! I BET
YOUR PROGRAMMING
SKILLS WILL BE EVEN

BETTER WHEN WE
MEET UP.

'-@L‘!:Aﬂ

...ACCORDING TO
NOAA SPECIALISTS,
THE SOLAR STORMS
AFFECTED RADIO
TRANSMISSIONS...

USE THE MAGIC WE COSMIC
GEMS TO RESTORE DEFENDERS THANK YOU,
BALANCE TO THE SCRATCHY AND MITCH. WE
UNIVERSE... CAN RETURN YOU TO YOUR
HOME DIMENSIONS NOW AND
REPAIR THIS HARM.

MITCH!

T'LL LEAVE THE SECRET
MANUAL WITH YOU
TO MAKE SURE YOU
REMEMBEEERRRRR...

- -

GLITTER

MAGIC GEM
BURST!

NOW WHAT
GAME SHOULD
WHAT A STRANGE I PROGRAM
DREAM. IT FELT
50 REAL, TOO.
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CLOSING THOUGHTS

I hope you've enjoyed the story of Mitch and Scratchy’s adventure,
and their success in defeating the Dark Wizard with their kind-
ness. I hope you've also experienced the power of hands-on learning
with Scratch. Designing games is one of the best ways to learn to
program.

But there is no single way to learn about technology. As long as
you have the spirit to take risks, learn from failure, stand by your
goals, and strive to excel, you will be able to learn a great deal. And
Scratch is an excellent tool for learning in such a practical fashion.

I sincerely hope that this book will encourage you to create
Scratch projects that surprise and delight your families and friends!

Edmond Kim Ping Hui

Team Leader and Registered Social Worker (HK)
Learning through Engineering, Art, and Design Project
The Hong Kong Federation of Youth Groups




Visit http://nostarch.com/scratch/ and download the Resources file.
When you unzip the file, you'll find:

Scratch projects The projects from the book, which you can
play, build on, remix, and reimagine! Don’t forget that you can
use these sprites, scripts, and sound effects in your very own
games. Just drag them into your Backpack (see page 39).

“Getting Started with Scratch” A short guide to key
Scratch concepts written by Scratch’s creators at MIT.

The Scratch Project also offers many resources.

SCRATCH-IMAGINE, PROGRAM, SHARE
http:/scratch.mit.edu/

This is the official website of Scratch. Here, you can
browse, play, and remix over a million different Scratch
projects from around the world!

PLAYABLE GAMES ON THE
SCRATCH WEBSITE
http:/scratch.mit.edu/users/nostarch/

This web page contains all of the projects
listed in this book. Comments are welcome,
and you can easily download these projects
to redesign them however you want!



SCRATCH WIKI
http:/wiki.scratch.mit.edu/

Scratch users have created a
wiki that contains a lot of inter-
esting content and articles.

SCRATCH FORUMS

http://scratch.mit.edu/
forums/index.php/

A forum for Scratchers to
share ideas and ask and

SCRATCHED answer questions.
http:/scratched.media.mit.edu/

An information-sharing website
created for teachers and other edu-
cators who use Scratch. Share your
success stories, exchange Scratch
resources, ask questions, and more.

LIFELONG KINDERGARTEN GROUP
AT MIT'S MEDIA LAB
http:/llk.media.mit.edu/

This 1s the birthplace of Scratch—the offi-
cial homepage for MIT Media Lab’s Lifelong
Kindergarten Group. You can learn more
about Professor Mitchel Resnick (the creator
of Scratch), and about other creative education
and design tools.
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UPDATES

Visit hitp:/nostarch.com/scratch
for updates, errata, and other information.

Super Scratch Programming Adventure! is set in Chevin, CCMeanwhile,
Century Schoolbook, House-A-Rama Kingpin (© House Industries), The
Sans Mono Condensed, and Kozuka Gothic Pro.
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6 As you read this book, let your imagination run wild.
What will you create with Scratch? 99
— FROM THE FOREWORD BY PROFESSOR MITCHEL RESNICK, CREATOR OF SCRATCH

COMICS! GAMES! PROGRAMMING!

Scratch is the wildly popular educational
programming language used by millions
of first-time learners in classrooms and
homes worldwide. By dragging together
colorful blocks of code, kids can learn
computer programming concepts and
make cool games and animations. The
latest version, Scratch 2, brings the lan-
guage right into your web browser, with
no need to download software.

In Super Scratch Programming Adventure!,
kids learn programming fundamentals
as they make their very own playable
video games. They’ll create projects
inspired by classic arcade games that
can be programmed (and played!) in an
afternoon. Patient, step-by-step expla-
nations of the code and fun program-
ming challenges will have kids creating
their own games in no time.
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PRICE: $24.95

This full-color comic book makes pro-
gramming concepts like variables, flow
control, and subroutines effortless to
absorb. Packed with ideas for games
that kids will be proud to show off,
Super Scratch Programming Adventure!
is the perfect first step for the budding
programmer.
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